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บทคัดย่อ 
 
 การศึกษาครั้งนี้มีวัตถุประสงค์เพื่อผลิตสื่อเทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยีความ
จริงเสริมเกี่ยวกับกลุ่มสาระการเรียนรู้ภาษาไทย ในหมวด สำนวนไทย และศึกษาความพึงพอใจของ
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ใช้ในการวิเคราะห์ข้อมูล ได้แก่ ค่าร้อยละ ค่าเฉลี่ย และส่วนเบี่ยงเบนมาตรฐาน ผลการศึกษาพบว่า 
ผลการประเมินความพึงพอใจ อยู่ในระดับมากที่สุด  
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Abstract 
 

 This research had a purpose to produce an augmented reality as an instructional 
media for Thai's subject, in category 'Thais idiom' and also surveys on the satisfaction 
of its student that used the media as well. The experimental group of this study was 
split into two groups. The first group was the 4th graded student for 20 persons. The 
second group was the teachers for 3 persons. Both parties are from Setsatian School 
for The Deaf Under the Royal Patronage. After an experiment, all the groups will assess 
all the media. The statistical data that will be analyzed were percentile, average, and 
standard deviation. The result of this research showed the satisfactory result from the 
experts, the teachers, and the hearing-impaired students that they all have satisfaction 
on the highest level. 
  
Keywords: Augmented reality, Hearing impaired 
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กิตติกรรมประกาศ 
 
 โครงงานพิเศษฉบับนี้สำเร็จลุล่วงไปได้ด้วยความอนุเคราะห์ข้อมูลและการสนับสนุนข้อมูลจาก
บุคคลหลายท่าน โดยเฉพาะอย่างยิ่งผู้จัดทำขอขอบพระคุณ อาจารย์ ดร.นุจรี บุรีรัตน์ อาจารย์ที่
ปรึกษาโครงงาน อาจารย์ ดร.วิชชพร เทียบจัตุรัส อาจารย์ประจำวิชาการบริหารจัดการการผลิตงาน
มัลติมีเดีย และผู้ช่วยศาสตราจารย์ ดร.ฉันทนา ปาปัดถา อาจารย์ประจำวิชาโครงงานพิเศษทาง
เทคโนโลยีมัลติมีเดีย ที่ได้กรุณาตรวจทาน แก้ไขและให้คำแนะนำทั้งในเรื่องของข้อมูล หัวข้อโครงาน
พิเศษ เอกสารประกอบ การทำตาราง และการจัดหน้าโครงงานต่าง ๆ  ในการทำรายงานโครงงาน
พิเศษนี้มาโดยตลอด 
 ขอขอบคุณ กรรมการผู้สอบทุกท่าน ที่ให้คำช้ีแนะเพื่อนำมาปรับปรุงแก้ไขโครงานพิเศษนี้ให้ได้
ล ุล ่วงตามเป้าหมาย และขอขอบคุณ คณะอาจารย์ทุกท่านที ่ให้การอบรมสั ่งสอน ให้ความรู้  
ความช่วยเหลือแก่คณะผู้จัดทำและแนะนำข้อสงสัยต่าง ๆ ตลอดมา ขอขอบคุณ อาจารย์สายใจ สังข
พันธ์ รองผู้อำนวยการโรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ โดยอาจารย์ได้อนุญาตให้นักเรียนเป็น
กลุ่มตัวอย่างในการทดลองครั้งนี้ อีกทั้งยังให้ความสนใจแก่ผลงานของคณะผู้จัดทำ พร้อมทั้งให้ความ
สะดวก คอยช่วยเหลือ และให้คำแนะนำเรื่องต่าง ๆ  และขอขอบคุณนักเรียนระดับชั้นประถมศึกษา
ชั้นปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ ที่ให้ความร่วมมือ และมีมิตรภาพที่ดีให้แก่คณะ
ผู้จัดทำ 
 ขอขอบคุณ ดร.ชิณญ์ ทรงอมรสิริ ผู้จัดการฝ่ายการตลาด บรรณาธิการ สนพ. ช ช้าง ที่ได้ให้
การสนับสนุนในส่วนของการจัดพิมพ์หนังสือสำนวน สุภาษิต และคำพังเพย และพนักงานจากบริษัท 
บีพีเค พริ้นต้ิง จำกัด ที่ได้คอยช่วยเหลือ และให้ข้อมูลในการจัดพิมพ์หนังสือ  
 ขอขอบคุณ คุณพ่อคุณแม่ของคณะผู้จัดทำ ที่คอยให้กำลังใจ และคอยให้คำสั่งสอนเสมอมา 
รวมถึงเพื่อน ๆ ที่เป็นกำลังใจ คอยช่วยเหลือเกื้อกูลกันมาตลอด ไม่ว่าจะเป็นเรื่องเล็กน้อยไปจนถึง
เรื่องใหญ่ และยังคอยให้คำปรึกษาเรื่องงาน ให้คำแนะนำในเรื่องต่าง ๆ และสุดท้าย ขอขอบคุณ คณะ
ผู้จัดทำในกลุ่มโครงงานพิเศษ ที่ช่วยกันทำรายงานโครงงานฉบับนี้ออกมาอย่างสมบูรณ์ และสำเร็จ
ลุล่วงไปด้วยดี 
 โครงงานพิเศษนี้ได้รับทุนจากโครงการส่งเสริมสิ่งประดิษฐ์และนวัตกรรมเพื ่อนคนรุ่น ใหม่
ประจำปีงบประมาณ 2563 มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร  
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บทท่ี 1 
บทนำ 

 
1.1 ที่มาและความสำคัญของโครงงาน 
 ในปัจจุบันสังคมของเรามีผู้ที่มีความบกพร่องทางการได้ยินอยู่มาก แต่เพราะด้วยข้อจำกัดทาง
ร่างกายซึ่งคือการสื่อสารกับผู้คนปกติในสังคมไม่ได้มากเท่าที่ควรนั้น ทำให้ผู้ที่บกพร่องทางการได้ยิน
แทบหมดโอกาสในการทำงานในสังคม เพียงเพราะพวกเขาไม่ได้รับการเรียนรู้และการศึกษาเท่าที่ควร
ได้รับดังเช่นผู้คนปกติทั่ว ๆ ไป การศึกษานั้นเป็นโอกาสที่ทุกคนควรได้รับอย่างเท่าเทียมกันไม่ว่า
ผู้เรียนนั้นจะมีความบกพร่องทางร่างกาย อารมณ์หรือสติปัญญาก็ตาม 
 ในแต่ละช่วงวัย วัยเด็กถือเป็นวัยที่เหมาะแก่การเรียนรู้สิ่งต่าง ๆ  โดยเฉพาะวัยเด็กตอนปลาย
เป็นวัยที่มีระดับทางสติปัญญาเพิ่มมากขึ้น เริ่มมีจินตนาการกว้างไกล เข้าใจในสิ่งรอบตัว มีความจำที่
แม่นยำมากขึ้น และเป็นวัยที่กำลังเปิดรับความรู้ในเรื่องต่าง ๆ  ซึ่งการปลูกฝังการเรยีนรู้ให้กบัเด็กนั้นก็
ถือเป็นรากฐานของการเติบโตในอนาคต แต่เด็กที่มีปัญหาในด้านการได้ยิน จะมีข้อจำกัดในการเรียนรู้ 
เพราะหากไม่ใช่โรงเรียนเฉพาะทางของผู้บกพรอ่งทางการได้ยิน ก็จะไม่มีผู้มีความรู้เกี่ยวกับผู้บกพร่อง
ทางการได้ยินหรือจะไม่มีการเรียนการสอนสำหรับผู้บกพร่องทางการได้ยินอยู่ในแบบการเรียนการ
สอนในโรงเรียนทั่ว ๆไป ในประเทศไทยมีโรงเรียนเฉพาะทางของผู้บกพร่องทางการได้ยินอยู่เป็น
จำนวนมาก หนึ่งในน้ันคือ โรงเรียนเศรษฐเสถียร โดยโรงเรียนเศรษฐเสถียร เป็นโรงเรียนรัฐบาล สังกดั
กองการศึกษาเพื่อคนพิการ กระทรวงศึกษาธิการ เป็นโรงเรียนสอนคนหูหนวกแห่งแรกของประเทศ
ไทย พัฒนาขึ ้นมาจากหน่วยทดลองสอนคนหูหนวกโรงเรียนเทศบาล 17 (วัดโสมนัสวรวิหาร) 
กรุงเทพมหานคร ซึ่งตั้งข้ึนเมื่อวันที่ 10 ธันวาคม 2494 ต่อมาในวันที่ 25 มีนาคม 2495 คุณหญิงโต๊ะ 
นรเนติบัญชากิจ ได้มีจิตศรัทธาบริจาคทรัพย์สิน มีเงินสด ที่ดิน และบ้านส่วนตัวของท่าน ซึ่งตั้งอยู่  
ณ เลขที่ 137 ถนนพระราม 5 ตำบลถนนนครไชยศรี อำเภอดุสิต จังหวัดพระนคร ตั้งเป็นมูลนิธิให้ช่ือ
ว่า “มูลนิธิเศรษฐเสถียร” เพื่อเป็นอนุสรณ์แห่งตระกูล “เศรษฐบุตร” อันเป็นตระกูลของพระยานร
เนติบัญชากิจ สามีของท่าน กับตระกูล “โชติกเสถียร” ซึ่งเป็นตระกูลของคุณหญิงเอง มูลนิธิเศรษฐ
เสถียร มีวัตถุประสงค์ที่จะร่วมมือกับ กระทรวงศึกษาธิการ ในการจัดสร้างโรงเรียนสอนคนหูหนวกขึน้
ในที ่ดินแห่งนี้ ในปี พ.ศ.2496 กระทรวงศึกษาธิการได้จัดสรรงบประมาณในการก่อสร้างอาคาร 
โรงเรียนสอนคนหูหนวกและงบประมาณสำหรับครุภัณฑ์และการดำเนินงานของโรงเรียน ในปีที่
บรรจบครบรอบปีที่ 2 แห่งการจัดการศึกษาสำหรับคนหูหนวกในประเทศไทย ซึ่งตรงกับวันที่ 10 
ธันวาคม 2496 ได้มีพิธีเปิดโรงเรียนสอนคนหูหนวกในประเทศไทยขึ้นอย่างเป็นทางการ ต่อมาในปี 
พ.ศ. 2504 โรงเร ียนสอนคนหูหนวกแห่งนี ้ ได้เปลี ่ยนชื ่อ เป็น โรงเร ียนสอนคนหูหนวกดุสิต  
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อันเนื่องมาจากกระทรวงศึกษาธิการ ได้จัดตั้งโรงเรียนสอนคนหูหนวกแห่งใหม่ขึ้นที่บริเวณอาคาร
สงเคราะห์ทุ่งมหาเมฆ โดยในปี พ.ศ.2518  กระทรวงศึกษาธิการได้มีนโยบายให้โรงเรียนสอนคนหู
หนวกทั่วประเทศ เปลี่ยนชื่อ จากโรงเรียนสอนคนหูหนวก เป็นโรงเรียนโสตศึกษาจังหวัดต่าง ๆ 
คณะกรรมการมูลนิธิอนุเคราะห์คนหูหนวก ได้เสนอเปลี ่ยนชื ่อโรงเรียนสอนคนหูหนวกดุสิต  
เป็นโรงเรียนเศรษฐเสถียร เพื่อเป็นอนุสรณ์แด่ มูลนิธิเศรษฐเสถียร ที่ยุบเลิกไป จึงปรากฏช่ือโรงเรียน
เศรษฐเสถียร ตั้งแต่ 1 มกราคม 2518 และต่อมาเมื่อวันที่ 26 กันยายน 2545 สมเด็จพระบรมโอรสาธิ
ราชฯ สยามมกุฎราชกุมาร ทรงพระกรุณาโปรดเกล้าฯ รับโรงเรียนเศรษฐเสถียร ไว้ในพระราชูปถัมภ์ 
ซึ่งเป็นโรงเรียนสอนคนหูหนวกแห่งแรกของประเทศไทยที่ได้รับพระราชทาน 
 การเรียนการสอนสำหรับผู้บกพร่องทางการได้ยินน้ัน สื่อทางการศึกษาที่สำคัญและสอดคล้อง
กับวิธีการรับรู้ ของผู้บกพร่องทางการได้ยินมีประมาณ 3 ประเภท ไม่ว่าจะเป็นสื่อที่รับรู้ได้ด้วยการ
มองเห็น สื่อที่มีทั้งภาพและเสียง หรือแม้แต่สื่อเทคโนโลยีคอมพิวเตอร์ก็ยังเป็นสื่อทางการศึกษาที่  
ผู้บกพร่องทางการได้ยินใช้เป็นสื่อการเรียนการสอนได้ ถึงแม้ว่าผู้บกพร่องทางการได้ยินจะมีข้อจำกัด
ในการเรียนรู้มากกว่าคนปกติทั่วไป แต่ผู้บกพร่องทางการได้ยินก็ยังควรได้รับการเรียนการสอนที่เป็น
รูปแบบใหม่ๆ เช่นกัน และควรที่จะได้รับสื่อที่หลากหลาย และตรงตามศักยภาพซึ่งจะช่วยให้สามารถ
รับรู้สื่อการเรียนการสอนนี้ได้ง่ายขึ้น เช่น ภาษา ภาษามือ ตัวอักษร รูปภาพ การตอบโต้ในรูปแบบ
ต่าง ๆ คณะผู้จัดทำได้เล็งเห็นว่าเทคโนโลยีความจริงเสริม (Augmented Reality หรือ AR) เป็นสื่อที่
สามารถตอบโจทย์ความต้องการของการเรียนการสอนสำหรับผู้บกพร่องทางการได้ยินได้ เพราะเป็น
สื่อที่มีทั้งภาพ เสียง และเป็นเทคโนโลยีที่หลากหลายรูปแบบ ทั้งนี้จะมีการนำเทคโนโลยีความจริง
เสริม (Augmented Reality หรือ AR) ผสมผสานกับหนังสือเสริมการเรียนการสอน โดยเทคโนโลยี
เหล่านี้จะช่วยให้ผู้บกพร่องทางการได้ยินมีโอกาสในการเรียนรู้เพิ่มมากขึ ้น และได้ใช้เทคโนโลยี
รูปแบบใหม่ๆ เช่นเดียวกับผู้คนปกติทั่วไป จากการสำรวจเบื้องต้นพบว่าทางโรงเรียนเศรษฐเสถียร ใน
พระราชูปถัมภ์ ต้องการสื่อการเรียนการสอนเกี่ยวกับกลุม่สาระการเรียนรู้ภาษาไทย ในหมวด สำนวน
ไทย เพื่อเพิ่มความน่าสนใจให้กับการเรียนการสอน และหากได้มีหนังสือเสริมการเรียนการสอน
ประกอบการเรียนสำหรับผู้บกพร่องทางการได้ยินด้วยแล้วจะทำให้เพิ่มช่องทางการเรียนรู้ให้ง่ายมาก
ข้ึน ทั้งยังเป็นการเปิดโอกาสให้ผู้บกพร่องทางการได้ยินได้ใช้เทคโนโลยีรูปแบบใหม่ด้วย 
 ดังนั้นคณะผู้จัดทำจึงได้เล็งเห็นความสำคัญของการเรียนการสอนด้วยเทคโนโลยีรูปแบบใหม่
สำหรับผู้ที่บกพร่องทางการได้ยินด้วยเทคโนโลยีความจริงเสริม (Augmented Reality หรือ AR) และ
หนังสือเสริมการเรียนการสอนโดยเป็นสื่อการเรียนการสอนที่มีรูปแบบที่เหมาะสมกับผู้บกพร่อง
ทางการได้ยินที่อยู่ในช่วงวัยเด็กตอนปลาย ระดับชั้นประถมศึกษาปีที่ 4 ทั้งการใช้ภาษา ภาษามือ 
ตัวอักษร รูปภาพ การตอบโต้ในรูปแบบต่าง ๆ รวมไปถึงเนื้อหาและการออกแบบที่ดึงดูดความสนใจ
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ของวัยเด็กตอนปลาย มีเนื้อหาเกี่ยวกับกลุ่มสาระการเรียนรู้ภาษาไทย ในหมวด สำนวนไทย เพื่อช่วย
เพิ่มเสริมความรู้ของผู้บกพร่องทางการได้ยิน 
 

1.2 วัตถุประสงค์ของโครงงาน 
 1.2.2 เพื่อผลิตสื่อเทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยี AR เกี่ยวกับกลุ่มสาระการ
เรียนรู้ภาษาไทย ในหมวด สำนวนไทย 
 1.2.2 เพื่อศึกษาความพึงพอใจของผู้เรียนต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยี
ความจริงเสริมในรูปแบบเทคโนโลยี AR 
 

1.3 ขอบเขตการศึกษาโครงงาน 
 1.3.1 ด้านเนื้อหา 
  การศึกษาครั ้งนี ้ได้อิงเนื ้อหาจากในกลุ ่มสาระการเร ียนรู ้ภาษาไทย สำหรับช้ัน
ประถมศึกษา ช้ันปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ โดยมุ่งเน้นศึกษาในเรื่องของ สำนวน
ไทย เพื่อนำมาใช้พัฒนาร่วมกับสื่อเสริมการเรียนการสอน 
 1.3.2 ด้านประชากรและกลุ่มตัวอย่าง 
  ประชากรที่ใช้ในการศึกษาครั้งนี้แบ่งออกเป็น 2 กลุ่ม คือ นักเรียนช้ันประถมศึกษาปทีี่ 
4 โรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์ จำนวน 20 คน และอาจารย์ประจำโรงเรียนเศรษฐเสถยีร
ในพระราชูปถัมภ์ จำนวน 3 คน 
 1.3.3 ด้านตัวแปรที่ศึกษา 
  ตัวแปรต้น = หนังสือความจริงเสริมในรูปแบบเทคโนโลยี AR  
  ตัวแปรตาม = ความพึงพอใจของนักเรียนช้ันประถมศึกษาปีที่ 4 โรงเรียนเศรษฐเสถียร
ในพระราชูปถัมภ์ และอาจารย์ประจำโรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์  ต่อหนังสือความจริง
เสริมในรูปแบบเทคโนโลยี AR 
 1.3.4 ด้านพื้นที่ 
  โรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์ 
 1.3.5 ด้านเวลา 
  โครงงานนี้ใช้ระยะเวลาในการจัดทำตั้งแต่เดือนธันวาคม 2561-เดือนมีนาคม 2563 
โดยมีรายละเอียด ดังนี้ 
  เก็บรวบรวมข้อมูล    เดือนธันวาคม 
  นำข้อมูลปรึกษาผู้เชียวชาญและอาจารย์ เดือนมกราคม - กุมภาพันธ์ 
  สอบเปิดหัวข้อโครงงาน   เดือนมีนาคม 
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  จัดทำผลงาน     เดือนมีนาคม - สิงหาคม 
  แก้ไขผลงาน     เดือนสิงหาคม – ตุลาคม 
  ทดลองใช้ผลงาน    เดือนพฤศจิกายน 
  นำผลงานส่งโรงพิมพ์    เดือนธันวาคม 
  เก็บข้อมูลผลสำรวจความเหมาะสม  เดือนมกราคม 
  สอบปิดหัวข้อโครงงาน   เดือนกุมภาพันธ์ 
  เผยแพร่และนำไปใช้    เดือนมีนาคม 
 

1.4 คำนิยามศัพท์เฉพาะ 
 เพื่อความเข้าใจที่ถูกต้องตรงตามวัตถุประสงค์ของโครงการคณะผู้จัดทำจึงขอกำหนดความหมายของ
ศัพท์ต่าง ๆ  ที่ใช้ในงานโครงการ ดังนี ้ 
 เทคโนโลยีความจริงเสริม (Augmented Reality หรือ AR) หมายถึง เทคโนโลยีใหม่ ที่นำเอา
โลกแห่งความเป็นจรงิเข้ากับโลกเสมือน โดยผ่านอุปกรณ์อิเล็กทรอนิกส์รว่มกับการใช้ซอฟต์แวร์ตา่ง ๆ 
ทำให้สามารถมองเห็นภาพที่มีลักษณะเป็นวัตถุแสดงผลในจอภาพกลายเป็นวัตถุ 3 มิติ ลอยอยู่เหนือ
พื้นผิวจริง ซึ่งจะนำเสนอเกี่ยวกับสำนวนไทย 
 หนังสือเสริมการเรียนการสอนเทคโนโลยี AR หมายถึง หนังสือที่สอดแทรกการเรียนการสอน 
โดยใช้เทคโนโลยี AR มาผสมผสานทำให้หนังสือมีความน่าสนใจมากขึ้น หนังสือเสริมการเรียนการ
สอนเทคโนโลยี ซึ่งจะนำเสนอเนื้อหาเกี่ยวกับสำนวนไทย 
 ผู้บกพร่องทางการได้ยิน หมายถึง บุคคลที่บกพร่องหรือสูญเสียทางการได้ยินเป็นเหตุให้รับฟัง
เสียงต่าง ๆ ได้ไม่ชัดเจน ตั้งแต่ระดับน้อยถึงระดับรุนแรง โดยอาจจะได้ยินเพียงเล็กน้อยเท่านั้น หรือ
อาจไม่ได้ยินเลย และจะใช้การสื่อสารโดยใช้ภาษามือ ซึ่งศึกษาเฉพาะภายในโรงเรียนเศรษฐเสถียร 
 ในราชูปถัมภ์ 
 

1.5 ประโยชน์ที่คาดว่าจะได้รับ 
 1.5.1 ได้หนังสือเสริมการเรียนการสอนสำหรับเด็กที่มีความบกพร่องทางการได้ยิน 
 1.5.2 ได้สื่อเทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยี AR เกี่ยวกับกลุ่มสาระการเรียนรู้
ภาษาไทย ในหมวด สำนวนไทย 
 1.5.3 ไดท้ราบถึงความพึงพอใจของผู้เรียนต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยี
ความจริงเสริมในรูปแบบเทคโนโลยี AR 



บทท่ี 2 
แนวคิด ทฤษฎี และงานวิจัยท่ีเก่ียวข้อง 

 
 การวิจัยเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอน “สำนวนไทย” สำหรับผู้บกพร่อง
ทางการได้ยิน ในครั้งนี้ผู้วิจัยได้ทำการศึกษาได้ทำการศึกษาแนวคิด ทฤษฎี และงานวิจัยที่เกี่ยวขอ้ง 
เพื่อใช้เป็นแนวทางในการศึกษา อภิปราย และสรุปผลการวิจัย ดังต่อไปนี้ 
  2.1 แนวคิดเกี่ยวกับการออกแบบ 
  2.2 แนวคิดเกี่ยวกับสื่อสิ่งพมิพ ์
  2.3 แนวคิดเกี่ยวกับกลุม่สาระการเรียนรู้ภาษาไทย 
  2.4 แนวคิดเกี่ยวกับเทคโนโลยีความจริงเสริม 
  2.5 งานวิจัยที่เกี่ยวข้อง 
 

2.1 แนวคิดเก่ียวกับการออกแบบ 
 2.1.1 Animation 
  Animation หมายถึง การสร้างภาพเคลื่อนไหว โดยมีหลักการคือ การนำภาพนิ่ง
หลายๆภาพ ซึ่งมีความต่อเนื่องกันมาแสดงด้วยความเร็วที่เหมาะสม หรือที่เรียกว่า Frame Rates ทำ
ให้เกิดภาพลวงตาของการเคลื่อนไหว หรือภาพจำติดตา (Iconic Memory) ในสื่อภาพเคลื่อนไหวทุก
ชนิด จะมี Frame Rates ซึ่งหมายถึง จำนวนเฟรม (จำนวนภาพนิ่ง) โดยมีหน่วยเป็น Per Second 
(กี่ภาพต่อวินาที) เรียกกันย่อๆว่า FPS (Frame Rates Second) เช่น 24 FPS คือใน 1 วินาทีจะมี
ภาพน่ิงต่อกัน 24 ภาพ มักจะจำกัดไว้ที่ 60 FPS เนื่องจากสายตาคนเราแยกแยะออกก็ได้เพียงเท่านั้น 
มากกว่านี้ก็ไม่มีประโยชน์ และเปลืองหน่วยความจำของเครื่องโดยไม่จำเป็น ถ้าค่า FPS สูงความลื่น
ไหลของภาพน้ันจะดูต่อเนื่อง สวยงาม ไม่ดูข้ามเฟรม หรือโดดจนเกินไป ถ้าค่า FPS ต่ำ จะทำให้ภาพน
นั้นดูกระตุกๆ ไม่ต่อเนื่อง ดูแล้วเสียอารมณ์ 
  โดยปกติความเร็วของแอนิเมชันจะฉายด้วยความเร็วที่ต่างกันขึ้นอยู่กับชนิดของการ
แสดงผล โดยถ้าฉายเป็นภาพยนตร์จะฉายด้วยความเร็ว 24 เฟรมต่อวินาที ถ้าถ่ายทอดในระบบ PAL 
จะว่ิงด้วยความเร็ว 25 เฟรมต่อวินาที โดยแอนิเมชันจะแบ่งเป็น 2 ประเภท คือ 2D แอนเิมชัน ที่ผู้ชม
สามารถมองเห็นทั้งความสูงและความกว้าง ซึ่งจะมีความเหมือนจริงพอสมควร และในการสร้างจะมี
สลับซับซ้อนมากนัก และ 3D แอนิเมชันที่ผู้ชมสามารถมองเห็นทั้งความสูง ความกว้างและความลึก 
ภาพที่เห็นจะมีความสมจริงมากถึงมากที่สุด 
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  2.1.1.1 รูปแบบของแอนิเมชัน 
   1. Drawn Animation คือ แอนิเมชันที ่เกิดจากการวาดภาพทีละภาพ
หลายๆพันภาพ แต่การฉายภาพเหล่านั้นผ่านกล้องอาจใช้เวลาไม่กี่วินาที ข้อดีของการทำแอนิเมชัน
ชนิดนี้คือ มีความเป็นศิลปะ สวยงาม น่าชม ข้อเสียคือ ต้องใช้เวลานานในการผลิต ต้องใช้แอนิเมเตอร์
จำนานมากและต้นทุนก็สูงตามไปด้วย 
   2. Stop Motion หรือเรียกว่า Model Animation เป็นการถ่ายภาพแต่
ละขณะของหุ่นจำลองที่ค่อยๆขยับ อาจจะเป็นของเล่นหรืออาจจะสร้างจาก Plasticine วัสดุที่คล้าย
กับดินน้ำมันโดยโมเดลที่สร้างขึ้นสามารถใช้ได้อีกหลายครั้ง และยังสามารถผลิตได้หลายตัว แต่การทำ 
Stop Motion ต้องอาศัยเวลาและความทุ่มเทมาก บริษัทที่ผลิตภาพยนตร์เรื่อง James and Giant 
Peach สามารถผลิตได้วันละ 10 วินาทีเท่านั้น 
   3. Computer Animation ปัจจุบันมีซอฟต์แวร์ที่สามารถช่วยให้การทำ
แอนิเมชันง่ายขึ้น เช่น โปรแกรม Blender,MAYA ,3DMAX, Adobe Flash เป็นต้น วิธีนี้เป็นวิธีที่
ประหยัดเวลาการผลิตและลดต้นทุนเป็นอย่างมาก เช่น ภาพยนตร์เรื่อง Toy Story ใช้แอนิเมเตอร์
เพียง 110 คนเท่านั้น 
  2.1.1.2 สตอรี่บอร์ด 
   สตอรี่บอร์ด คือ ชุดของภาพวาด ข้อความ ก่อนการแสดงผลในการผลิต
ภาพเคลื่อนไหว หรือภาพยนตร์ เป็นเครื่องมือที่จำเป็นสำหรับผูอ้ำนวยการสร้างเพื่อกำหนดทิศทางใน
การทำ การเล่าเรื่อง ลำดับเรื่อง มุมกล้อง สถานที่ เวลา ซึ่งภาพที่วาดไม่จำเป็นต้องละเอียดมาก 
เหมือนการสเกตซ์ภาพของเฟรมต่างๆ ให้เล่าเรื่องราวจากบทเปรยีบเสมอืนการวาดรูปการ์ตูนในกรอบ
สี่เหลี่ยมแต่ละช่อง ช่วยประหยัดเวลา งบประมาณ ช่วยให้ผู้กำกับภาพมองเห็นมุมกล้องก่อน ช่วยให้
เนื้อเรื่องลื่นไหวเพราะได้อ่านทวน ตั้งแต่ต้นจนจบก่อนจะลงมือจริง 
   บทบาทหลักของสตอรี่บอร์ดคือ การถ่ายทอดเรื่องราวได้อย่างมีประสิทธิภาพ 
ใกล้เคียงที่สุดกับภาพเคลื่อนไหว ภาพยนตร์ หรือเรื่องที่ต้องการแสดงออกมา นั่นหมายความว่าเมื่อมีคน
อ่านสตอรี่บอร์ดแล้วสามารถเข้าใจถึงเรื่องราวที่นำเสนอได้ทันทีตั้งแต่ต้นจนจบ สิ่งที่จะช่วยถ่ายทอด
เรื่องราวในสตอรี่บอร์ด ไดแ้ก่ 
   1. ภาพ คำอธิบายภาพ 
   2. บทพูด บทสนทนา  
   3. เสียงประกอบ เสียงดนตรี 
   4. การเคลื่อนไหวของกล้อง มุมกล้อง ขนาดภาพ แสดงให้เห็นว่า ตัวละคร 
ฉาก เคลื่อนไหว 
   5. การเปลี่ยนภาพไปยัง Scene ถัดไป 
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   6. ใช้สีวัตถุที่แตกต่างจากพื้นหลัง (สมรักษ์ ปิยะเวที, 2560) 

 2.1.2 ทฤษฎีสี 
  สี (COLOUR) หมายถึง ลักษณะกระทบต่อสายตาให้เห็นเป็นสีมีผลถึงจิตวิทยา คือมี
อำนาจให้เกิดความเข้มของแสงที่อารมณ์และความรู้สึกได้ การที่ได้เห็นสีจากสายตาสายตาจะส่ง
ความรู้สึกไปยังสมองทำให้เกิดความรู้สึก ต่างๆตามอิทธิพลของสี เช่น สดช่ืน ร้อน ตื่นเต้น เศร้า สีมี
ความหมายอย่างมากเพราะศิลปินต้องการใช้สีเป็นสื่อสร้างความประทับใจในผลงานของศิลปะและ
สะท้อนความประทับใจนั้นให้บังเกิดแก่ผู้ดูมนุษย์เกี่ยวข้องกับสีต่างๆ อยู่ตลอดเวลาเพราะทุกสิ่งที่อยู่
รอบตัวนั้นล้วนแต่มีสีสันแตกต่างกันมากมาย สีเป็นสิ่งที่ควรศึกษาเพื่อประโยชน์กับตนเองและ ผู้สร้าง
งานจิตรกรรมเพราะ เรื่องราวองสีนั้นมีหลักวิชาเป็นวิทยาศาสตร์จึงควรทำความเข้าใจวิทยาศาสตร์ 
ของสีจะบรรลุผลสำเร็จในงานมากขึ้น ถ้าไม่เข้าใจเรื่องสีดีพอสมควร ถ้าได้ศึกษาเรื่องสีดีพอแล้ว  
งานศิลปะก็จะประสบความสมบูรณ์เป็นอย่างยิ่ง (artfunclub, 2556) 
  2.1.2.1 รูปแบบของสีที่เกิดจากแสง (RGB Color) 
   รูปแบบสีที่เกิดจากแสงจะใช้สีแดง (Red), สีเขียว (Green) และสีน้ำเงิน 
(Blue) เป็นแม่สีหลัก เพื่อผลิตแสงสีในรูปแบบต่างๆ ยกตัวอย่าง เช่นแสงสีแดงผสมกับแสงสีเขียวจะ
ได้แสงสีเหลือง หรือแสงสีแดงผสมกับแสงสีน้ำเงินก็จะได้แสงสีม่วงแดง เป็นต้น แนวคิดของรูปแบบสี 
RGB นี้มีพื้นฐานมาจากทฤษฎีของนักฟิสิกส ์‘ยังและเฮล์มโฮลทซ์’ (The Young-Helmholtz Theory 
– ว่าด้วยการมองเห็นสีเกิดขึ้นเนื่องจากความแตกต่างกันของเซลล์ Cone ในเรติน่า) RGB จึงเป็น
รูปแบบของสีที่ใช้อธิบายปรากฏการณ์แสงเป็นหลัก ดังนั้นระบบดังกล่าวจึงถูกนำไปใช้ประโยชน์ใน
การผลิตสีให้กับจอภาพแทบทุกอย่าง ไม่ว่าจะเป็นโทรทัศน์ , โปรเจกเตอร์ และอื่นๆ อีกมากมาย  
การรวมตัวของสีในรูปแบบนี้เราเรียกกว่าเป็นการรวมตัวแบบบวก (Addictive Color) เมื่อรวมตัวกัน
ทั้งสามแม่สีจะได้สีขาผ 

 
 

ภาพที่ 2.1 สี RGB 
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  2.1.2.2 รูปแบบของสีสำหรบังานพมิพ์ (CMYK) 
   CMYK เป็นรูปแบบสีที่ถูกกำหนดขึ้นมาให้ใช้สำหรับงานศิลปะหรืองานสื่อ
สิ่งพิมพ์ลงบนวัตถุ ประกอบด้วย 4 แม่สีหลักได้แก่สีฟ้า (Cyan), สีม่วงแดง (Magenta), สีเหลือง 
(Yellow) และสีดำ (Black) สาเหตุที่ต้องมีสีดำเนื่องจากว่าการผสมสีระหว่างสีฟ้า + สีม่วงแดง และสี
เหลืองทำให้ได้สีดำที่ไม่ดำสนิท จึงต้องมีการถมดำลงไปอีกครั้ง ดังนั้นระบบพิมพ์ 4 สีจึงหมายถึง 4 
แม่สีนี้นั่นเอง การรวมตัวของสีในรูปแบบนี้เราเรียกว่าเป็นการรวมตัวแบบลบ (Subtractive Color) 
ท้ายที่สุดแล้วการรวมตัวของทุกแม่สีจะได้สีดำ ซึ่งตรงกันข้ามกับระบบ RGB 

 
 

ภาพที่ 2.2 สี CMYK 
 

  2.1.2.3 ความสัมพันธ์ของระบบสี RGB และ CMYK 
   จากระบบสสีองระบบทีก่ล่าวมานั้น ทำใหเ้ราทราบถึงความตรงกันข้ามของ
แต่ละแม่สีในทั้งสองระบบด้วย ได้แก่ สีแดงในระบบ RGB ตรงข้ามกบัสฟี้าในระบบ CMYK, สเีขียวใน
ระบบ RGB ตรงข้ามกบัสมี่วงแดงในระบบ CMYK และ สีน้ำเงินในระบบ RGB ตรงข้ามกบัสเีหลืองใน
ระบบ CMYK ทัง้หมดนีเ้พราะสีขาวในระบบแสงสีตรงข้ามกบัสีดำในระบบสีวัตถุธาตุ 

 

 
 

ภาพที่ 2.3 สีตรงข้าม RGB และ CMYK 
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   แต่ในความเป็นจริงนั้นยังมีสิ่งที่ทำให้ผลลัพธ์คลาดเคลื่อนหรือไม่แม่นยำอีก
มากมาย เช่น สีที่ผลิตได้จากทั้งสองระบบมีไม่เท่ากัน , ความผิดเพี้ยนของสิ่งที่ผลิต หรือแม้แต่ตัว
ผู้ใช้งานมันเองและอื่นๆอีกมาก 
  2.1.2.4 กลุ่มโทนรอ้น (Warm Colors) 
   สีโทนร้อน หมายถึง ชุดสีที่ประกอบด้วย สีส้มเหลือง สีส้ม สีส้มแดง สีแดง 
และสีม่วงแดง สีวรรณะร้อนให้ความรู้สึกตื่นตา มีพลัง อบอุ่น สนุกสนาน และดึงดูดความสนใจได้ดี 
โครงสีร้อนน้ีสภาพโดยรวมจะมีความกลมกลืนของสีมากควรมีสีเย็นมาประกอบบ้างทำให้ภาพมีความ
น่าสนใจมากขึ้น 
  2.1.2.5 กลุ่มโทนเย็น (Cool Colors) 
   สีโทนเย็น หมายถึง ชุดสีที่ประกอบด้วยสีเขียวเหลือง สีเขียว สีเขียวน้ำเงิน 
สีน้ำเงิน และสีม่วงน้ำเงิน โครงสีเย็นให้ความรู้สึกสุภาพ สงบ ลึกลับ เยือกเย็น ในทางจิตวิทยาสีเย็นมี
ความสัมพันธ์กับความรู้สึกหดหู่ เศร้า โครงสีเย็นควรมีสีร้อนแทรกบ้างจะทำให้ผลงานดูน่าสนใจมาก
ข้ึน (Wuttipong Nim-orn,2562) 

 

 
 

ภาพที่ 2.4 โทนของส ี
 

2.2 แนวคิดเก่ียวกับสื่อสิ่งพิมพ์ 
 สิ่งพิมพ์ที่พบเห็นโดยทั่วไปประกอบด้วยองค์ประกอบสำคัญหลายอย่าง ได้แก่ ตัวอักษรหรือ
ข้อความภาพประกอบเนื้อที่ว่าง และส่วนประกอบอื่น การออกแบบสิ่งพิมพ์ที่ต้องคำนึงถึงการจัดวาง
องค์ประกอบต่าง ๆ ดังกล่าวเข้าด้วยกันโดยใช้หลักการ ดังนี้ 
 2.2.1 ทิศทางและการเคลื่อนไหว (Direction & Movement) 
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  เมื่อผู้รับสารมองดูสื่อสิ่งพิมพ์ การรับรู้เกิดขึ้นเป็นลำดับตามการมองเห็น กล่าวคือ  
เกิดตามการวาดสายตาจากองค์ประกอบหนึ่งไปยังอีกองค์ประกอบหนึ่ง จึงมีความจำเป็นอย่างยิ่ง  
ที่จะต้องมีการดำเนินการวางแผน กำหนดและชักจูงสายตาผู้รับสารให้เคลื่อนไหวในทิศทางที่ถูกต้อง 
ตามลำดับขององค์ประกอบที่ต้องการให้รับรู้ก่อนหลัง โดยทั่วไปหากไม่มีการสร้างจุดเด่ นขึ ้นมา 
สายตาของผู ้ร ับสารจะมองดูหน้ากระดาษที ่เป็นสื ่อสิ ่งพิมพ์ในทิศทางที ่เป็นตัวอักษร ( Z) ใน
ภาษาอังกฤษ คือ จะเริ่มที่มุมบนด้านขวาตามลำดับการจัดองค์ประกอบที่สอดคล้องกับธรรมชาติการ
มองนี้ เป็นส่วนช่วยให้เกิดการรับรู้ตามลำดับที่ต้องการ 

 

 
 

ภาพที่ 2.5 หนังสือจุลสาร 
 

 2.2.2 เอกภาพและความกลมกลืน (Unity & Harmony) 
  เอกภาพคือความเป็นอันหนึ่งอันเดียวกัน ซึ่งในการจัดทำเลย์เอาต์หมายถึงการเอา
องค์ประกอบที่แตกต่างกันมาวางไว้ในพื้นที่หน้ากระดาษเดียวกันอย่างกลมกลืน ทำหน้าที่สอดคล้อง
และส่งเสริมกันและกันในการสื่อสารความคิดรวบยอด และบุคลิกภาพของสื่อสิ่งพิมพ์นั้น ๆ  
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ภาพที่ 2.6 วารสารความร่วมมือกับต่างประเภท 
 

 2.2.3 ความสมดุล (Balance) 
  หลักการเรื่องความสมดุลนี้เป็นการตอบสนองธรรมชาติของผู้รับสาร ในเรื่องของแรง
โน้มถ่วง โดยการจัดวางองค์ประกอบทั้งหมดในพื้นที ่หน้ากระดาษ จะต้องไม่ขัดกับความรู้สึกนี้  
คือ จะต้องไม่ดูเองเอียงหรือหนักไปด้านใดด้านหนึ่ง โดยไม่มีองค์ประกอบมาถ่วงในอีกด้าน การจัด
องค์ประกอบให้เกิดความสมดุลแงได้เป็น 3 ลักษณะ คือ 
  1. สมดุลแบบสมมาตร (Symmetrical Balance) เป ็นการจัดวางองค์โดยให้
องค์ประกอบในด้านซ ้ายและด้านขวาพื ้นท ี ่หน ้ากระดาษมีล ักษณะเหม ือนกันทั ้งสองข ้ าง  
ซึ่งองค์ประกอบที่เหมือนกันในแต่ละด้านน้ีจะถ่วงน้ำหนักกันและกันให้ความรู้สึกสมดุล 
  2. สมดุลแบบอสมมาตร (Asymmetrical Balance) เป็นการจักวางองค์ประกอบ
โดยให้องค์ประกอบในด้านซ้ายและด้านขวาพื้นที่หน้ากระดาษมีลักษณะไม่เหมือนกันทั้งสองข้าง แม้
องค์ประกอบจะไม่เหมือนกันในแต่ละด้านแต่ก็จะถ่วงน้ำหนักกันและกันให้เกิดความสมดุล 
  3. สมดุลแบบรัศมี  (Radial Balance) เป ็นการจัดวางองค ์ประกอบ โดยให้
องค์ประกอบแผ่ไปทุกทิศทางจากจุดศูนย์กลาง 
 2.2.4 สัดส่วน (Proportion) 
  การกำหนดสัดส่วนน้ีเป็นการกำหนดความสัมพันธ์ในเรื่องของขนาดซึ่งมีความสัมพันธ์
โดยเฉพาะในหน้ากระดาษของสื่อสิ่งพิมพ์ที่ต้องการให้มีจุดเด่น เช่น หน้าปกหนังสือเป็นต้น เพราะ
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องค์ประกอบที่มีสัดส่วนแตกต่างกันจะดึงดูดสายตาได้ดีกว่าการใช้องค์ประกอบทั้งหมดในสัดส่วนที่
ใกล้เคียงกัน ในการกำหนดสัดส่วนจะต้องกำหนดองค์ประกอบทั้งหมดในพื้นที ่หน้ากระดาษไป  
พร้อม ๆ กันว่าควรจะเพิ่มหรือลดองค์ประกอบใดไม่ใช่ค่อย ๆ ทำไปทีละองค์ประกอบ 
 2.2.5 ความแตกต่าง (Contrast) 
  เป็นวิธีที่ง่ายที่สุด โดยการเน้นให้องค์ประกอบใดองค์ประกอบหนึ่งเด่นข้ึนมาด้วยการ
เพิ่มขนาดใหญ่กว่าองค์ประกอบอื่น ๆ  โดยรอบ เช่น พาดหัวขนาดใหญ่ เป็นต้น ซึ่งโดยธรรมชาติแล้วผู้
ดูจะเลือกดูองค์ประกอบใหญ่ก่อน 
 2.2.6 จังหวะ ลีลา และการซ้ำ (Rhythm & Repetition) 
  การจัดวางองค์ประกอบหลาย ๆ  ชิ้นโดยกำหนดตำแหน่งให้เกิดมีมีช่องว่าเป็นช่วง ๆ  
ตอน ๆ อย่างมีการวางแผนล่วงหน้า จะทำให้เกิดลีลาขึ้น และหากว่าองค์ประกอบหลาย ๆ  ชิ้นนั้นมี
ลักษณะซ้ำกันหรือใกล้เคียงกัน ก็จะยิ่งเป็นการเน้นให้เกิดจังหวะลีลา ได้ชัดเจนย่ิงข้ึนลักษณ์ตรงข้าม
กับแบบแรก จังหวะและลีลาลักษณะนี้จะก่อให้เกิดความรู ้สึก ที ่ตื ่นเต้นดูเคลื ่อนไหวและมีพลัง
(pongnuntipisek,2558) 
 

2.3 แนวคิดเก่ียวกับกลุ่มสาระการเรียนรู้ภาษาไทย 
 2.3.1 สำนวน 
  จะมีความหมายโดยนัย เป็นลักษณะความหมายเชิงอุปมาเปรียบเทียบ จะไม่แปล
ความหมายตรงตามตัวอักษร จึงฟังแล้วมักจะ ไม่ได้ความหมายของตัวมันเอง ต้องนำไปประกอบกับ
บุคคล กับเรื่อง หรือเหตุการณ์จึงจะได้ความหมายเป็น คติ เตือนใจเช่นเดียวกับคำที่เป็นสุภาษิต 
 2.3.2 สุภาษิต 
  หมายถึง คำกล่าวที ่มีคติควรฟัง มีจุดมุ ่งหมายเพื ่อการสั ่งสอน เตือนสติให้ได้คิด  
แบ่งออกเป็นสองประเภท คือ 
  1. เมื่ออ่าน หรือ ฟังแล้วสามารถเข้าใจเนื้อความได้ทันที โดยไม่ต้องแปลความหมาย 
ตีความหมายเช่น ไก่งามเพราะขนคนงามเพราะแต่ง 
  2. เมื่ออ่าน หรือ ฟังแล้ว ไม่สามารถเข้าใจเนื้อความนั้นในทันที ต้องนึกตรกึตรอง 
ต้องแปลความ ตีความหมายเสียก่อนจึงจะทราบเนื้อแท้ของคำเหล่าน้ัน เช่น ผีบ้านไม่ดีผีป่าก็พลอย 
 2.3.3 คำพังเพย 
  หมายถึง ถ้อยคำที่เรียบเรียงขึ้นมา แฝงคติเตือนใจหรือ ข้อคิดสะกิดใจให้นำไปปฏิบัติ
ได้ เป็นความหมายกลาง ๆ  คือ ไม่เน้นการสั่งสอน และ เนื้อหาของใจความนั้นก็ไม่จำเป็นว่าจะตอ้ง
เป็นความดี หรือ ความจริงแท้ แน่นอน 
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 2.3.4 ความแตกต่างของ สุภาษิต สำนวน และคำพังเพย 
  สุภาษิต จะไม่มีการเสียดสีหรือติชมอย่างคำพังเพย เป็นถ้อยคำที่แสดงหลักความจริง 
เป็นที่ยอมรับกันโดยทัว่ ๆ  ไป ภาษิตน้ียังมีความหมายรวมไปถึง สัจธรรม คำสั่งสอนที่เป็นความจรงิอนั
เที่ยงแท้ทางศาสนาด้วย เช่น ตนเป็นที่พึ่งแห่งตน เป็นต้น (ณัฐชานนท์ ทะกาศ, 2557) 
 

2.4 แนวคิดเก่ียวกับเทคโนโลยีความจริงเสริม 
 2.4.1 Augmented Reality (AR) 
  AR เป็นเทคโนโลยีใหม่ ที่ผสานเอาโลกแห่งความเป็นจริง (Real) เข้ากับโลกเสมือน 
(Virtual) โดยผ่านอุปกรณ์ทางด้านฮาร์ดแวร์รวมกับการใช้ซอฟต์แวร์ต่าง ๆ  ทำให้สามารถมองเห็น
ภาพที่มีลักษณะเป็นวัตถุ (Object) แสดงผลในจอภาพกลายเป็นวัตถุ 3 มิติ ลอยอยู่เหนือพื้นผิวจริง  
มีการแสดงผลที่แสดงวัตถุมีการเคลื่อนไหว ดูมีมิติมีความตื่นเต้นเร้าใจ โดยสามารถนำรูปแบบใหม่ของ
การนำเสนอสินค้าลอยออกมานอกจอคอมพิวเตอร์ ซึ ่งเป็นการนำเสนอรูปแบบใหม่ในโลกสังคม
ออนไลน์หรือการตลาดออนไลน์อีกทางหนึ่ง ว่ากันว่า นี่จะเป็นการเปลี่ยนแปลงโฉมหน้าสื่อยุคใหม่ 
พอๆ กับเมื่อครั้งเกิดอินเทอร์เน็ตข้ึนในโลกก็ว่าได้ หากเปรียบสื่อต่าง ๆ เสมือน “กล่อง” แล้ว AR คือ
การเด้งออกมาสู่โลกใหม่ภายนอกกลอ่งที่สรา้งความตื่นเต้นเรา้ใจ ในรูปแบบ Interactive Media โดย
แท้จริง 

 
 

ภาพที่ 2.7 การสแกน AR 
 

  เทคโนโลยีเสมือนจริงนี้ มีหลักการทำงานโดยสามารถแบ่งประเภทตามส่วนวิเคราะห์
ภาพ (Image Analysis) เป็น 2 ประเภท ได้แก่ การวิเคราะห์ภาพโดยอาศัย Marker เป็นหลักในการ
ทํางาน (Marker based AR) และการวิเคราะห์ภาพโดยใช้ลักษณะต่าง ๆ  ที่อยู่ในภาพมาวิเคราะห์ 
(Marker-less based AR) หลักการของเทคโนโลยีเสมือนจริง ประกอบด้วย 
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  1. Marker (หรือทีเ่รียกว่า Markup) 
  2. กล้องวิดีโอ เว็บแคม กล้องโทรศัพทม์ือถือ หรอื ตัวจับ Sensor อื่นๆ 
  3. ส่วนการแสดงผลภาพ เช่นจอภาพจากอปุกรณ์แสดงผล 
  4. ซอฟต์แวร์ส่วนประมวลผลเพื่อวัตถุแบบสามมิติ object 3D 
 2.4.1 พื้นฐานหลกัของ AR 
  ใช้หลักการของการตรวจจับการเคลื่อนไหว (Motion Detection) การตรวจจับการ
เต้นหรือการเคาะ (Beat Detection) การจดจําเสียง (Voice Recognize) และการประมวลผลภาพ 
(Image Processing) โดยนอกจากการตรวจจับการเคลื่อนไหวผ่าน Motion Detect แล้ว การตอบสนอง
บางอย่างของระบบผ่านสื่อนั้น ต้องมีการตรวจจับเสียงของผู้ใช้และประมวลผลด้วยหลักการ Beat 
Detection เพื่อให้เกิดจังหวะในการสร้างทางเลือกแก่ระบบ เช่น เสียงในการสั่งให้ตัว  Interactive 
Media ทํางาน 
  ทั้งนี้การสั่งการด้วยเสียงจัดว่าเป็น AR และในส่วนของการประมวลผลภาพนั้น เป็น
ส่วนเสริม เพราะเน้นไปที่การทํางานของปัญญาประดิษฐ์ (Artificial Intelligent: AI) ในการสื่อ
อารมณ์กับผู้ใช้บริการผ่านสีและรูปภาพ 
  เทคโนโลยี AR นี้จะสามารถทำให้ผู้ใช้เห็นภาพเสมือนจริงได้รอบ โดยไม่จำเป็นจะต้อง
เดินทางไปสถานที่จริง หากในอนาคตเทคโนโลยีจะมีความก้าวหน้าเป็นอย่างไร สิ่งสำคัญที่สุดคือ
ความก้าวหน้าของมนุษย์ก็ต้องพัฒนาควบคู่กันไปด้วย หากเรามีเทคโนโลยีที่ล้ำสมัยให้ใช้ แต่มนุษย์
ไม ่ได้เจริญตามเทคโนโลยีด้วย การดำรงชีวิตของมนุษย์ก็จะไม่เป็นปกติสุขได้เลย(จิราภรณ์ 
ปกรณ์,2561) 

 

 
 

ภาพ 2.8 ตัวอย่างการสแกน AR 
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2.5 งานวิจัยที่เก่ียวข้อง 
 ณัฏฐพงศ์ กาญจนฉายา และคณะ (2561:บทนำ) จากการศึกษาการพัฒนาการ์ตูนแอนิเมชัน
ปฏิสัมพันธ์ 2 มิติ เรื่อง พลเมืองดี เพื่อสร้างความรู้ในการเปน็พลเมืองดีของนักเรียนช้ันประถมศึกษาปี
ที่ 5 พบว่า แอนิเมชันเป็นการนำเสนอภาพประกอบ การ์ตูนที่มีเนื้อหาเรื่องราวรูปแบบหนึ่งที่ได้รับ
ความนิยม มากที่ผู้สอนในการนำมาถ่ายทอดความรู้ให้กับนักเรียน โดยการ์ ตูนแอนิเมชันสามารถ
บรรยายเนื้อหาเรื่องราว ด้วยตัวเอง การแสดงออกจะใช้ท่าทาง หน้าตา น้ำเสียง อารมณ์ของตัวละคร 
ประกอบกับสีสนัของฉากที่ให้ บรรยากาศซึ่งเป็นการเลา่เรือ่งด้วยภาพมากกว่าคำพูด ของตัวละครเปน็
หลัก เป็นศิลปะของการเคลื่อนไหว ที่เล่าเรื่องด้วยท่าทางและการแสดงผ่านการใช้ตัวละคร เพื่อผูก
โยงเรื่องเพื่ออธิบาย ขยายความ แสดงหรือนำเสนอ ความรู้โดยอาศัยออกแบบเรื่องราวและเนื้อหาให้
เหมาะสม ซึ่งการใช้การ์ตูนแอนิเมชันจะเหมาะกับวิชาที่มีเนื้อหาใน ด้านการสร้างความเข้าใจ กระตุ้น
ความสนใจ เช่น พุทธศาสนา สังคมศึกษา วิทยาศาสตร์ในชีวิตประจำวัน กฎหมายและจริยธรรม  
มีวิธีการนำไปใช้เช่น การใช้ ละครนำเข้าสู่บทเรียน การใช้ละครนำเสนอเนื้อหา 
 ปิยธิดา สังฆะโณ (2550:บทนำ) จากการศึกษา การพัฒนาบทเรียนสําเร็จรูปการ์ตูน เรื่อง 
สํานวน สุภาษิต และคําพังเพย ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียนมหาวชิราวธุ จ.สงขลา 
พบว่า สํานวน หมายถึง ถ้อยคํา หรือ ข้อความที่กล่าวสืบต่อกันมาช้านาน มีความหมายไม่ตรงตัว หรอื
มีความหมายแฝงอยู่ เช่น สอนจระเข้ใหว่ายน้ำ รําไม่ดีโทษปี่ โทษกลอง เป็นต้น สุภาษิต หมายถึง 
ถ้อยคํา หรือข้อความที่กล่าวสืบทอดกันมาช้านาน มี ความหมายเป็นคติสอนใจ เช่น รักยาวให้บั่น รัก
สั้นให้ต่อ หรือน้ำเช่ียวอย่าขวางเรือ เป็นต้น และคําพังเพย หมายถึง ถ้อยคําหรือข้อความที่กล่าวสืบ
ต่อกันมาช้านาน โดยตีความให้เข้ากับ เรื่อง เช่น กระต่ายต่ืนตูม เป็นต้น 
 สุบิน ไชยยะ (2560: บทนำ) จากการศึกษาการใช้เทคโนโลยีเสมือนจริงในห้องสมุดประชาชน 
สรุปได้ว่า การนำ เทคโนโลยีเสมือนจริงมาใช้ในห้องสมุดประชาชนถือเป็นมิติใหม่ทางด้านสื่อการ
เรียนรู้ทำให้ผู้ใช้บริการ มีความสนใจใฝ่เรียนรู้อยากรู้อยากเห็น เรียนรู้สิ่งใหม่ สร้างประสบการณ์ที่
แปลกใหม่ และมีส่วนร่วมในการเรียนรู้ได้เพิ่ม มากขึ้น สร้างผลิตผลที่มีความหมายกับตนเอง เกิด
ปฏิสัมพันธ์เชื่อมโยงในการนำเอาประสบการณ์เข้าสู่สถานการณ์จริงที่ ผสมผสานกับสถานการณ์
เสมือนจริงึ่งเทคโนโลยีหนึ่งที่ได้รับความนิยมในการนำ มาประยุกต์ ใช้เพื่อให้บริการในห้องสมุด
ประชาชน คือ เทคโนโลยีเสมือนจริง (Augmented reality: AR) 



 
 

บทท่ี 3 
วิธีการดำเนินงาน 

 
 ในการศึกษาโครงงานเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้
บกพร่องทางการได้ยิน มีขั้นตอนและการดำเนินงาน ดังนี้ 

3.1 ประชากรและกลุ่มตัวอย่าง 
3.2 เครื่องมือที่ใช้ในการศึกษา 
3.3 วิธีการเก็บรวบรวมข้อมูล 
3.4 สถิติที่ใช้ในการวิเคราะห์ข้อมูล 
3.5 ข้ันตอนดำเนินการ 

 

3.1 ประชากรและกลุ่มตัวอย่าง 
 โครงงานนี้มีขอบเขตของประชากรและกลุ่มตัวอย่าง ดังนี้ 
 3.1.1 ประชากรที่ใช้ในการศึกษาครั้งนี้ ได้แก่ นักเรียนและอาจารย์ภายในโรงเรียนเศรษฐ
เสถียร ในพระราชูปถัมภ์ 
 3.1.2 กลุ่มตัวอย่างที่ใช้ในการศึกษาครั้งนี้แบ่งเป็น 2 กลุ่ม ได้แก่ 
  กลุ่มที่ 1 ผู้เชี่ยวชาญ และอาจารย์ภายในโรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ 
จำนวน 3 คน 
  กลุ ่มที ่ 2 นักเร ียนระดับชั ้นประถมศึกษาปีที่  4 โรงเร ียนเศรษฐเสถียร ในพระ
ราชูปถัมภ์ ซึ่งเป็นผู้บกพร่องทางการได้ยิน จำนวน 20 คน  
   

3.2 เครื่องมือที่ใช้ในการศึกษา 
 3.2.1 สื่อเทคโนโลยีความจริงเสริมการเรียนการสอนในรูปแบบเทคโนโลยี AR  
 3.2.2 แบบสอบถามความพึงพอใจต่อสื ่อเทคโนโลยีความจริงเสริมการเรียนการสอนใน
รูปแบบเทคโนโลยี AR  
  โดยแบบสอบถามมีลักษณะเป็นแบบสอบถามปลายปิด โดยที่มีคำตอบไว้ให้ผู้ตอบ
เลือกคำตอบจากความเป็นจริง และคำถามแบบปลายเปิด โดยที่ให้ผู้ตอบสามารถแสดงความคิดเห็น
ได้อย่างอิสระ การตอบแบบสอบถามจะให้ผูต้อบตอบคำถามผ่านกูเกิ้ลฟอรม์และนำไปสรุปผลโดยการ
ใช้ร่วมกับโปรแกรมเอ็กเซล โดยมีแบบสอบถาม 2 ชุด เพื ่อใช้สำหรับกลุ ่มตัวอย่างทั ้ง 2 กลุ่ม  
โดยแบบสอบถามจะมีดังนี้ 
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  3.2.2.1 แบบสอบถามสำหรับอาจารย์ภายในโรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์ 
   ส่วนที่ 1 เป็นแบบสอบถามเกี่ยวกับปัจจัยด้านประชากรศาสตร์ของผู้ตอบ
แบบสอบถาม เป็นข้อมูลทั่วไปของผู้ตอบแบบสอบถาม คำถามจะถูกออกแบบเพื่อสอบถามข้อมูล
ทั่วไปจำนวน 1 ข้อ ได้แก่ เพศ โดยผู้ตอบแบบสอบถามจะต้องเลือกคำตอบที่ตรงกับคุณลักษณะของ
ตัวเองเท่านั้น 
   ส่วนที่ 2  เป็นแบบสอบถามเกี่ยวกับความพึงพอใจต่อการออกแบบหนังสือ
เสริมการเรียนการสอน ความถูกต้องเนื้อหาที่สอดคล้องกับวัตถุประสงค์ วีดีทัศน์การเรียนการสอน 
และเทคนิคการนำเสนอ 
   ส่วนที่ 3  เป็นแบบสอบถามปลายเปิด เพื ่อให้ผู ้ตอบแบบตอบสอบถาม
สามารถเสนอข้อคิดเห็น หรือข้อเสนอแนะเพิ่มเติม 
  3.2.2.2 แบบสอบถามสำหรับนักเรียนระดับชั้นประถมศึกษาปีที่ 4 โรงเรียนเศรษฐ
เสถียร ในพระราชูปถัมภ์ 
   ส่วนที่ 1 เป็นแบบสอบถามเกี่ยวกับปัจจัยด้านประชากรศาสตร์ของผู้ตอบ
แบบสอบถาม เป็นข้อมูลทั่วไปของผู้ตอบแบบสอบถาม คำถามจะถูกออกแบบเพื่อสอบถามข้อมูล
ทั่วไปจำนวน 1 ข้อ ได้แก่ เพศ โดยผู้ตอบแบบสอบถามจะต้องเลือกคำตอบที่ตรงกับคุณลักษณะของ
ตัวเองเท่านั้น 
   ส่วนที่ 2 เป็นแบบสอบถามเกี่ยวกับความพึงพอใจต่อการออกแบบหนังสือ
เสริมการเรียนการสอน วีดีทัศน์การเรียนการสอน และเทคนิคการนำเสนอ ซึ่งเป็นคำถามแบบปลาย
ปิด โดยมีระดับความพึงพอใจเป็น 3 มาตราวัด ได้แก่ มาก ปานกลาง น้อย 
 

3.3 วิธีการเก็บรวบรวมข้อมูล 
 ในการศึกษาครั้งนี้ คณะผู้จัดทำได้เก็บรวบรวมข้อมูลด้วยตนเอง โดยใช้แบบสอบถามในการ
ประเมินความพึงพอใจต่อสื่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่อง
ทางการได้ยิน มีขั้นตอนการเก็บรวบรวมข้อมูล คือ คณะผู้จัดทำจะให้กลุ่มตัวอย่างทั้ง 2 กลุ่ม ได้
ทดลองใช้สื่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน 
และทำการประเมินความพึงพอใจผ่านแบบสอบถามที่ทำคณะผู้จัดทำสร้างขึ้น 
 

3.4 สถิติที่ใช้ในการวิเคราะห์ข้อมูล 
 สถิติที่ใช้ในการประเมินความพึงพอใจต่อสื่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวน

ไทยสำหรับผู้บกพรอ่งทางการได้ยิน ด้วยการวิเคราะห์หาค่าร้อยละ หาค่าเฉลี่ย (x̅) และส่วนเบี่ยงเบน
มาตราฐาน (S.D) จากกลุ่มตัวอย่างโดยการหาค่าร้อยละ ค่าเฉลี่ย และส่วนเบี่ยงเบนมาตรฐาน 
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3.5 ขั้นตอนการดำเนินการ 
 โครงงานพิเศษเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่อง
ทางการได้ยิน มีขั้นตอนการดำเนินงานอย่างละเอียด ดังต่อไปนี้ 
 3.5.1 คิดหัวข้อโครงงานพิเศษ 
  คณะผู้จัดทำได้ประชุมกันเพื่อคิดหาหัวข้อโครงงานพิเศษ โดยสมาชิกได้พบเห็นคลิปวีดี
ทัศน์เกี่ยวกับเด็กทารกที่เป็นผู้บกพร่องทางการได้ยินได้ใส่เครื่องช่วยฟังและได้ยินเสียงมารดาครั้งแรก 
ทำให้สมาชิกรู้สึกประทับใจจึงได้นึกถึงผู้บกพร่องทางการได้ยินกับการเรียนรู้ของพวกเขา ว่าหากขาด
การได้ยินพวกเขาจะมีวิธีการเรียนหนังสืออย่างไร คณะผู้จัดทำจึงได้ศึกษาและค้นคว้าข้อมูล จนได้พบ
กับสื่อการเรียนการสอนผ่านเทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยี AR จึงได้คิดว่าหากนำ
เทคโนโลยี AR มารวมกับการเรียนการสอนสำหรับผูบ้กพร่องทางการได้ยิน อาจจะทำให้การเรียนการ
สอนนั้นดูน่าสนใจและพัฒนาสื่อการเรียนการสอนให้เท่าเทียมกับบุคคลทั่วไปก็ได้ จึงได้นำเสนอ
อาจารย์ประจำวิชาการบริการจัดการการผลิตงานมัลติมีเดีย จนได้โครงงานพิเศษเรื่อง เทคโนโลยี
ความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน 
 3.5.2 ส่งหนังสือขออนุญาตจากทางมหาวิทยาลัย 
  คณะผู้จัดทำได้จัดทำคำร้องเพื่อขอหนังสือจากทางมหาวิทยาลัยเพื่อขออนุญาตจัดทำ
โปรเจคร่วมกับทางโรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ ไว้สำหรับการยืนยันตัวของนักศึกษาและ
เพื่อความสะดวกในการติดต่องานในครั้งต่อ ๆ ไป 
 3.5.3 เข้าพบหน่วยงานเพื่อเสนอโครงงานพิเศษ 
  หลังจากได้มีการติดต่ออาจารย์สายใจ สังขพันธ์ รองผู ้อำนวยการโรงเรียนเศรษฐ
เสถียร ในพระราชูปถัมภ์ไปทางโทรศัพท์ ทางคณะผู้จัดทำจึงได้เดินทางไปที่โรงเรียน โดยมีการ
นำเสนอเนื้อหาและการออกแบบงานที่ได้สร้างขึ้นคร่าว ๆ  ทางอาจารย์ช่วยคณะผู้จัดทำดูเรื่องการ
ออกแบบตัวละครหลักและได้ให้มีการปรับแก้ตามความเหมาะสม รวมไปถึงการแก้ไขเนื้อหาบางส่วน 
เพราะ เนื้อหาบางส่วนมีความยาวและเข้าใจยากมากเกินกว่าประสิทธิภาพของผู้บกพร่องทางการได้
ยินจะสามารถรับรู้ได้ จึงได้มีการแก้ไขตามความเหมาะ และได้อนุญาตให้เริ่มทำได้ทันที 
 3.5.4 ข้ันตอนการออกแบบหนังสือเสริมการเรียนการสอน 
  ออกแบบตัวละครที่จะใช้เป็นตัวละครหลักในหนังสือเสริมการเรียนการสอน โดย
ออกแบบให้เป็นนักเรียนผู้หญิง 2 คน เป็นเหมือนตัวแทนคณะผู้จัดทำเอง 
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ภาพที่ 3.1 ภาพโครงร่างตัวละครหลัก 
 
  เปิดโปรแกรม Adobe Illustrator CC 2017 โดยโปรแกรมนี้จะใช้ในการวาดตัวละคร
หลัก และฉากต่าง ๆ รวมไปถึงการลงสีด้วย 

 

 
 

ภาพที่ 3.2 โปรแกรม Adobe Illustrator CC 2017 
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  สร้างไฟล์ใหม่ โดยเลือก New > Print > เลือกไซส์กระดาษ A4 และเลือกใช้ Color 
Mode เป็น CMYK เพื่อใช้สำหรับการปริ้นจากโรงพิมพ์ 

 

 
 

ภาพที่ 3.3 การตั้งค่าหน้ากระดาษ 
 

  นำภาพร่างตัวละครหลักมาลง กดเพื่อล็อคภาพไว้ > กด Create New Layer > 
แ ล ะ ใช้เครื่องมือPen Tool ในการวาดเส้น ตามภาพ โดยจะต้องวาดแยกเป็นส่วน เพราะ
จะทำให้ใช้ในข้ันตอนการทำโมชันได้ง่ายข้ึน และมีการปรับแก้สัดส่วนต่าง ๆ ให้สมบูรณ์ 

 

 
 

ภาพที่ 3.4 การร่างภาพตัวละครผ่านโปรแกรม Adobe Illustrator CC 2017 
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ในการเลือกจุดที่ต้องการลงสี จากนั้นเปลี่ยนสีโดยใช้  ในการเปลี่ยนสีผวิ ใ ช้  
เส้นผม เสื้อผ้า โดยเทียบสีจากชาร์ตสีหลาย ๆ แบบ เพื่อให้ได้ตามที่ต้องการ  

 

 
 

ภาพที่ 3.5 การลงสีตัวละคร 
 

  เมื ่อแก้ไขได้ตามที่ต้องการแล้ว กด File > Save > ตั้งชื ่อไฟล์งาน และเซฟด้วย
นามสกุลไฟล์ .ai เพื่อจะนำไปแก้ไขในหน้าเนื้อหาอื่น ๆ ได้ 

 

 
 

ภาพที่ 3.6 การเซฟงาน 
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  เปิดไฟล์ข้ึนมาใหม่ New > Print > เลือกไซส์กระดาษ A4 และเลือกใช้ Color Mode 
เป็น CMYK เพื่อใช้สำหรับการปริ้นจากโรงพิมพ์ เริ่มออกแบบฉากที่จะใช้ในเนื้อหาแต่ละหน้า โดยทำ
ในลักษณะเดียวกับตัวละครหลัก 

 

 
 

ภาพที่ 3.7 ภาพโครงร่างตัวละครหลักและฉากประกอบ 
 

 
 

ภาพที่ 3.8 ฉากประกอบที่สร้างจากโปรแกรม Adobe Illustrator CC 2017 
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  นำตัวละครหลักใส่ในฉาก และปรับขยับแต่ละส่วนให้เข้ากับตัวละครที่เคยวาดโครง
ร่างเอาไว้ 

 

 
 

ภาพที่ 3.9 การจัดวางตัวละครหลกัร่วมกับฉาก 
 

  เช็คความเรียบร้อย และกด File > Save > ตั้งช่ือไฟล์งานตามเนื้อหาน้ัน ๆ เพื่อที่จะ
ได้ไม่สับสนเวลานำไปใช้ร่วมกับโปรแกรมอื่น ๆ และเซฟด้วยนามสกุลไฟล์ .ai 

 
 

ภาพที่ 3.10 การเซฟงาน 
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3.5.5 ข้ันตอนการสร้างโมชัน AE 
  โปรแกรม Adobe After Effect CC 2018 โปรแกรมนี้ใช้งานด้วยการทำ Motion
ภาพเคลื่อนไหวต่าง ๆ ใส่เอฟเฟคให้มีความน่าสนใจมากขึ้น 

 

 
 

ภาพที่ 3.11 โปรแกรม Adobe After Effect CC 2018 
 

  เปิดโปรแกรม Adobe After Effect CC 2018 > ตรงแถบเมนูเลือก Composition 
ตั้งช่ืองาน,ขนาดวีดีโอ,และ Frame Rate > แล้วกด OK 

 

 
 

ภาพที่ 3.12 การสร้าง New Composition 
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  คลิกขวาตรงส่วนโปรเจค > Import > File เลือกไฟล์.ai เตรียมไว้ > กด Import 
 

 
 

ภาพที่ 3.13 การ Import ไฟล์ .ai 
 
  ลากไฟล์ .ai ที่ Import เข้ามาไปไว้ที่ หน้าต่าง Timeline เลือก Layer ที่จะใส่เอฟ   
เฟคต่าง ๆ  

 

 
 

ภาพที่ 3.14 ดึงไฟล์.ai มาใส่ Timeline 
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  เลือก Layer ที่จะทำการ Motion > ใส่ Key Frame ที่ Position และ Rotation โดย
กำหนดค่าเป็นตัวเลขหรือคลิกเมาส์ที่ตัวเลขค้างไว้แล้วเลื่อนข้ึนลงตามตัวเลขที่ต้องการ 

 

 
 

ภาพที่ 3.15 ใส่ Key Frame ให้เคลื่อนไหว 
 

  เม ื ่อทำการ Motion เสร ็จแล้ว ทำการ Export โดยกด File > Export > Add to 
Render Queue 

 

 
 

ภาพที่ 3.16 Export File ทีเ่สรจ็แล้ว 
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  เลือก “Best Settings” เพื่อตั้งค่า Composition และ Frame Rate ก่อน Render 
เมื่อตั้งค่าเสร็จเรียบร้อยแล้ว กด OK 

 

 
 

ภาพที่ 3.17 ตั้งค่า Composition และ Frame Rate 
 

  เลือก “Output Module” เลือก Format > Quick Time > OK จากนั้นกด Render 
 

 
 

ภาพที่ 3.18 ตั้งค่า Output Module กอ่น Render 
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 3.5.6 บันทึกวีดีทัศน์ภาษามือ 
  ทางคณะผู้จัดทำได้รับความช่วยเหลือจากโรงเรียนในการจัดหานักเรียนที่เชี่ยวชาญ
ด้านภาษามือมาช่วยในเรื่องของการบันทึกวีดีทัศน์ภาษามือ เพื่อนำไปประกอบกับโมชัน 

 

 
 

ภาพที่ 3.19 ภาพการบันทึกวีดีทัศน์ภาษามือ 
 
 3.5.7 ข้ันตอนการตัดต่อโมชันและภาษามือ 
  โปรแกรม Adobe Premiere Pro CC 2019 โดยโปแกรมนี้จะใช้ในข้ันตอนการตัดต่อ
วีดีทัศน์ภาษามือประกอบเข้ากับเสียง มีขั้นตอนการทำงานดังต่อไปนี้ 

 

 
 

ภาพที่ 3.20 โปรแกรม Adobe Premiere Pro CC 2019 
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  ตั้ง Project ข้ึนใหม่เลือก New Project ตั้งช่ือ Project > เลือก locationเก็บงาน > 
ตั้งค่า Project เลือก HDV > OK 

 

 
 

ภาพที่ 3.21 การตั้งค่า Project 
 

  คลิกบริเวณพื้นที่ Project > New Item > Sequence.. เพื่อทำการ New Sequence 
เลือก Settings > ตั้งค่าดังภาพ > OK 

 

 
 

ภาพที่ 3.22 การตั้งค่า Sequence 
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  เมื ่อตั ้งค่าแล้ว ทำการ Import วีดีโอ Motion วีดีโอภาษามือ และเสียงประกอบ 
จากนั้นลากไฟล์ทั้งหมดไปที่หน้าต่าง timeline จัดเรียง layer ตามลำดับ  

 

 
 

ภาพที่ 3.23 นำไฟล์มาใส่ Timeline 
 

  ทำการตัดต่อ จัดPosition ของวีดีโอตามความเหมาะสม โดยใส่วีดีภาษามือไว้ด้านล่าง
ขวาของหน้าจอ ใส่เอฟเฟคกรอบให้กับวีดีโอภาษามือ และใส่เสียงประกอบ 

 

 
 

ภาพที่ 3.24 ตัดต่อวีดีโอ Motion และวีดีโอภาษามือ 
 

  เมื่อทำการตัดต่อเรียบร้อย จึงทำการ Export วีดีโอออกมา เลือก File > Ex[ort > 
Media จะเปิดหน้าต่าง Export Settings 
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ภาพที่ 3.25 การ Export วีดีโอ 
 

  หน้าต่าง Export Settings เล ือกตั ้งค่า Format เป ็น H.264 ตั ้งค่า Preset เป็น 
Match Source - High bitrate และตั้งช่ือวีดีโอที่จะ Export จากนั้นกด Queue เพื่อ Export วีดโีอ 

 

 
 

ภาพที่ 3.26 หน้าต่าง Export Settings 
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 3.5.8 ข้ันตอนการสร้าง AR และแอปพลิเคชัน 
  ในข้ันตอนน้ีต้องใช้โปรแกรม Unity ควบคู่กับ Vuforia 
 

 
 

ภาพที่ 3.27 โปรแกรม Unity 
 

 
 

ภาพที่ 3.28 Vuforia 
 

  เข้าไปที ่ https://developer.vuforia.com/ ทำการ Login เข้าสู ่ระบบ จากนั้นไปที่ 
Target Manager > Add Target เลือกรูปที่จะใช้ใส่ลงไป เพื่อไว้ใช้สำหรับการจับภาพสแกนของแอป
พลิเคชันต่อรูปภาพ 
 

 
 

ภาพที่ 3.29  เนื้อหาที่ใส่ใน Target Manager 
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  เป ิดโปรแกรม Unity เล ือก New > ตั ้งชื ่อโปรเจค > เล ือก Location > เล ือก 
Template เป็น 3D และกด Create project 

 

 
 

ภาพที่ 3.30 การ Create project 
 

  คลิกขวาที ่พื ้นที ่ว่างช่อง Sample Scene > Vuforia Engine > Image เพื ่อสร้าง 
Image Target สำหรับการวางรูปที่จะใช้ในการสแกน 

 

 
 

ภาพที่ 3.31 การสร้าง Image Target 
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  คลิกขวาที่ Image Target > 3D Object > Plane เพื่อสร้าง Plane สำหรับใส่วีดโีอ
หลังการสแกน 

 

 
 

ภาพที่ 3.32 การสร้าง Plane 
 
  กลับไปที่ Vuforia คลิกที ่ Download Database (All) จาก Target ที ่ลงรูปภาพ
เนื้อหาไว้ เพื่อดาวน์โหลดเนื้อหามาไว้ในคอมพิวเตอร์ และคัดลอก License Manager ของ Target 
 

 
 

ภาพที่ 3.33 ดาวน์โหลด Database 
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ภาพที่ 3.34 คัดลอก License Manager 
 
  จากนั้นเลือก Assets > Resources จะมีหน้าโปรแกรมด้านขวาขึ้นมา นำ License 
Manager ที่คัดลอกมานั้น ใส่ลงในช่อง App License Key 

 

 
 

ภาพที่ 3.35 การเลือก Resources 
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ภาพที่ 3.36 การวาง License Manager 
 

  เลือก Image Target ไปที่โปรแกรมด้านขวา > เปลี่ยน Database ให้เป็น Target อัน
ที่เราสร้าง > เลือก Image Target เป็นรูปที่จะใช้ในการสแกน AR 

 

 
 

ภาพที่ 3.37 การใส่ภาพที่จะใช้ในการสแกน AR 
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  เลือก Plane ใน Image Target > ไปที ่โปรแกรมด้านขวา คลิกค้างที่คลิปวีดีโอที่
ต้องการ และลากไปใส่ที่ช่อง Video Clip โดยจะต้องตรวจให้แน่ชัดว่ารูปที่ใช้สแกนและวีดีโอเป็น
เนื้อหาเดียวกัน 

 

 
 

ภาพที่ 3.38 การใส่คลิปวีดีโอ 
 

  หลังจากเช็คความเรียบร้อยจนเป็นที่พอใจแล้ว ให้ทำการสร้างแอปพลิเคชันสำหรับ
หนังสือเสริมการเรียนการสอนโดยเฉพาะ โดยไปที่ File > Build Settings > เลือก Player Settings 
ไปที่โปรแกรมด้านขวา เลือก Select รูปโลโก้แอปพลิเคชันลงในช่อง Default Icon และ Default 
Cursor  

 

 
 

ภาพที่ 3.39 สร้างแอปพลิเคชัน 
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  กลับมาที่หน้า Build Settings > Build > เลือกโฟลเดอร์ที่จะติดตั้งแอปพลิเคชัน > 
Save และรอจนแอปพลิเคชันจะทำการติดตั้งเสร็จ แล้วจึงสามารถนำแอปพลิเคชันติดต้ังได้ 

 

 
 

ภาพที่ 3.40 โลโก้แอปพลิเคชัน 



 

บทท่ี 4 
ผลการดำเนินงาน 

 
ในการศึกษาโครงงานเรื ่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับ  

ผู้บกพร่องทางการได้ยิน สามารถนำเสนอการดำเนินงานตามวัตถุประสงค์ของโครงงานพิเศษ ดังนี้ 
4.1 ผลการผลิตส ื ่อเทคโนโลย ีความจริงเสร ิมการเร ียนการสอนสำนวนไทยสำหรับ 

ผู้บกพร่องทางการได้ยิน 
4.2 ผลการประเมินความพึงพอใจของผู้เชี่ยวชาญ และอาจารย์ผู้สอน โรงเรียนเศรษฐเสถียร 

ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความจริงเสรมิในรูปแบบเทคโนโลยี 
AR 

4.3 ผลการประเมินความพึงพอใจของนักเรียนระดับชั้นประถมศึกษาปีที่ 4 โรงเรียนเศรษฐ
เสถียร ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความจริงเสริมในรูปแบบ
เทคโนโลยี AR 

 

4.1 ผลการผลิตสื่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้
บกพร่องทางการได้ยิน 

จากการดำเนินการผลิตสื ่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับ 
ผู้บกพร่องทางการได้ยิน คณะผู้จัดทำโครงงานได้พัฒนาสื่อออกมาในรูปแบบหนังสือเสริมการเรียน
การสอน เรื่อง สำนวน สุภาษิต และคำพังเพย โดยหนังสือมีขนาด 21x21 นิ้ว จำนวน 21 หน้า พิมพ์
บนกระดาษอาร์ตมันขนาด 180 แกรม ด้วยการพิมพ์แบบปริ้นดิจิตอล ส่วนหน้าปกจะเพิ่มการเคลือบ
เงาเพื่อให้หน้าปกมีความหนาและแข็งแรง ภายในหนังสือเสริมการเรียนการสอนจะสามารถใช้ร่วมกับ
สื่อเทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยี AR โดยในแต่ละหน้าเนื้อหาจะแสดงสื่อวีดีทัศน์ของ
เนื้อหาน้ัน ๆ พร้อมทั้งมีวีดีทัศน์ภาษามือประกอบ ซึ่งผู้ใช้งานจะต้องดาวน์โหลดแอปพลิเคชันที่คณะ
ผู้จัดทำสร้างขึ้น ชื่อว่า ARdeaf ลงบนอุปกรณ์มือถือหรือแท็บเล็ต เพื่อใช้ในการสแกนรับชมวีดทีศัน์
นั้น ๆ โดยขณะจะได้ใช้เพียงแค่ระบบปฏิบัติการ Android เท่านั้น 

เนื้อหาภายในหนังสือเสริมการเรยีนการสอน เรื่อง สำนวน สุภาษิต และคำพังเพย จะมีทั้งหมด 
3 หมวด ได้แก่ สำนวน สุภาษิต คำพังเพย โดยใน 1 หมวด จะมีทั ้งหมด 5 คำ รวมเป็น 15 คำ 
นอกจากนีย้ังมีหน้าวิธีการใช้งานแอปพลิเคชัน และหน้าแนะนำตัวละครหลักที่อยู่ในหน้าเนื้อหาต่าง ๆ  
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รูปเล่มหนังสือเสริมการเรียนการสอน เรื่อง สำนวน สุภาษิต และคำพังเพย มีองค์ประกอบ 
ดังนี ้

 

 
 

ภาพที่ 4.1 หน้าหนังสอืเสริมการเรียนการสอน 
 

 
 

ภาพที่ 4.2 ปกหลงัหนงัสือเสริมการเรียนการสอน 
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ภาพที่ 4.3 หน้าสารบญั 
 

 
 

ภาพที่ 4.4 หน้าวิธีการใช้งาน และตัวละครหลัก 
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ภาพที่ 4.5 หน้าหมวดสำนวน และหน้าเนื้อหาคำว่า จับปลาสองมือ 
 

 
 

ภาพที่ 4.6 หน้าเนื้อหาคำว่า ดินพอกหางหมู และตำน้ำพริกละลายแม่น้ำ 
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ภาพที่ 4.7 หน้าเนื้อหาคำว่า ฝากปลาย่างไว้กับแมว และมือใครยาวสาวได้สาวเอา 
 

 
 

ภาพที่ 4.8 หน้าหมวดสุภาษิต และหน้าเนือ้หาคำว่า เขียนเสือให้วัวกลัว 
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ภาพที่ 4.9 หน้าเนื้อหาคำว่า กระต่ายขาเดียว และงมเข็มในมหาสมุทร 
 

 
 

ภาพที่ 4.10 หน้าเนื้อหาคำว่า หัวล้านได้หวี และกระต่ายหมายจันทร์ 
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ภาพที่ 4.11 หน้าหมวดคำพังเพย และหน้าเนือ้หาคำว่า น้ำกลิ้งบนใบบอน 
 

 
 

ภาพที่ 4.12 หน้าเนื้อหาคำว่า ปลาใหญ่กินปลาเล็ก และหว่านพืชเช่นไรได้ผลเช่นน้ัน 
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ภาพที่ 4.13 หน้าเนื้อหาคำว่า เข็นครกขึ้นภูเขา และเกบ็เบีย้ใต้ถุนร้าน 
 

 
 

ภาพที่ 4.14 หน้าบันทึก 
 

จากภาพที่ 4.1 – 4.14 เป็นการออกแบบหนังสือเสริมการเรยีนการสอนสำนวนไทยสำหรบัผู้
บกพรอ่งทางการได้ยิน โดยในหน้าเนื้อหาทั้งหมดจะสามารถใช้แอปพลิเคชัน ARdeaf ในการสแกน
เพื่อรบัชมสื่อวีดีทัศน์ที่ประกอบด้วยโมชันของเนื้อหาน้ัน ๆ และวีดีทัศน์ภาษามือ 
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4.2 ผลการประเมินความพึงพอใจของผู้เชี่ยวชาญ และอาจารย์ผู้สอนจากโรงเรียน
เศรษฐเสถียร ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความ
จริงเสริมในรูปแบบเทคโนโลยี AR 

การประเมินความพึงพอใจของการใช้เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทย
สำหรับผู้บกพร่องทางการได้ยิน โดยมีผู้เช่ียวชาญ และอาจารย์ทั้งหมด 3 ท่าน เป็นผู้ประเมินความพึง

พอใจหลังจากได้ทดลองใช้สื่อ ซึ่งทำการวิเคราะห์ข้อมูลด้วยการหาค่าร้อยละ (%) ค่าเฉลี่ย (x̅) และ
ส่วนเบี่ยงเบนมาตราฐาน (S.D.) สามารถนำเสนอผลการวิเคราะห์ข้อมูลได้ดังนี้ 

 4.2.1 ข้อมูลส่วนบุคคล ได้แก่ เพศ โดยทำการวิเคราะห์ด้วยการแจกแจงความถ่ี 
และค่าร้อยละ ดังนี้ 

 
ตารางที่ 4.1  ข้อมลูพื้นฐานของผู้ตอบแบบสอบถาม จำแนกตามเพศ 

เพศ จำนวน ร้อยละ 
1.ชาย 1 33.33 
2.หญิง 2 66.67 

รวม 3 100 
 
จากตารางที่ 4.1 แสดงข้อมูลพื้นฐานของผู้ตอบแบบสอบถาม จำแนกตามเพศ พบว่า ส่วนใหญ่

เป็นเพศหญิง ร้อยละ 66.67 และเพศชาย 33.33 
 
 4.2.2 เกณฑ์การประเมินของระดับความพึงพอใจในการใช้ความจริงเสริมในการ

สร้างสื่อเทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดย
กำหนดค่าเกณฑ์การประเมินเป็นแบบมาตรฐานความพึงพอใจออกเป็น 5 ระดับ ดังนี้ 

  5 หมายถึง มีคุณภาพอยู่ในระดับมากที่สุด 
  4 หมายถึง มีคุณภาพอยู่ในระดับมาก 
  3 หมายถึง มีคุณภาพอยู่ในระดับปานกลาง 
  2 หมายถึง มีคุณภาพอยู่ในระดับน้อย 
  1 หมายถึง หมายถึง มีคุณภาพอยู่ในระดับน้อยที่สุด 

และใช้เกณฑ์ตามมาตราวัดของลิเคิร์ท (Likert Scale) แปลความหมายดังนี้ 
  คะแนนค่าเฉลี่ย 4.50-5.00 หมายถึง มากที่สุด 
  คะแนนค่าเฉลี่ย 3.50-4.49 หมายถึง มาก 
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  คะแนนค่าเฉลี่ย 2.50-3.49 หมายถึง ปานกลาง 
  คะแนนค่าเฉลี่ย 1.50-2.49 หมายถึง น้อย 
  คะแนนค่าเฉลี่ย 1.00-1.49 หมายถึง น้อยที่สุด 
 

ตารางที่ 4.2  ผลการประเมินความพึงพอใจของผูเ้ช่ียวชาญ และอาจารยผ์ูส้อน โรงเรียนเศรษฐเสถียร 
ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความจริงเสริมใน
รูปแบบเทคโนโลยี AR 

รายการท่ีทำการประเมนิ 

ระดับความพึงพอใจ ผลการวิเคราะห์ข้อมูล 
มาก
ท่ีสุด 
(4) 

มาก 
 

(3) 

ปาน 
กลาง 
(2) 

น้อย 
 

(1) 

𝐱̅ S.D. ระดับ 
ความ 

พึงพอใจ 
ด้านเนื้อหา 
1.  เนื้อหาบทเรียนมีความ

สอดคล้องกบัวัตถุประสงค์ 
1 2 - - 4.33 0.58 มาก 

2.  การใช้ภาษาสามารถสือ่
ความหมายได้ชัดเจน 

2 1 - - 4.67 0.58 มากที่สุด 

3.  เนื้อหาสามารถเข้าใจได้ง่าย 2 1 - - 4.67 0.58 มากที่สุด 
4.  เนื้อหาของสื่อเป็นประโยชน์ต่อ

สังคม 
2 1 - - 4.67 0.58 มากที่สุด 

ด้านกราฟิกและการออกแบบ 
1.  การออกแบบหนังสือมีความ

สวยงาม 
2 1 - - 4.67 0.58 มากที่สุด 

2.  รูปภาพประกอบสามารถสื่อ
ความหมาย และมีความ
สอดคล้องกบัเนื้อหา 

3 - - - 5 0 มากที่สุด 

3.  วีดีโอภาษามือสามารถเข้าใจได้
ง่าย 

2 1 - - 4.67 0.58 มากที่สุด 

4.  เสียงบรรยาย และเสียง
ประกอบเหมาะสมกับเนื้อหา 

2 1 - - 4.67 0.58 มากที่สุด 
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ตารางที่ 4.2  (ต่อ) 

รายการท่ีทำการประเมนิ 

ระดับความพึงพอใจ ผลการวิเคราะห์ข้อมูล 
มาก
ท่ีสุด 
(4) 

มาก 
 

(3) 

ปาน 
กลาง 
(2) 

น้อย 
 

(1) 

𝐱̅ S.D. ระดับ 
ความ 

พึงพอใจ 
ด้านเทคนิค 
1.  มีวิธีการใช้งานที่เข้าใจง่าย และ

สะดวก 
2 1 - - 4.67 0.58 มากที่สุด 

2.  การใช้งานแอปพลิเคชันง่าย ไม่
ซับซ้อน 

2 1 - - 4.67 0.58 มากที่สุด 

3.  มีเทคนิครปูแบบการนำเสนอ
ผ่านอุปกรณ์ทีเ่หมาะสม 

2 1 - - 4.67 0.58 มากที่สุด 

4.  ประสิทธิภาพในการใช้งาน
โดยรวมมีความเหมาะสม 

1 1 1 - 4 0.58 มาก 

ความเหมาะสมในภาพรวม 4.58 0.56 มากท่ีสุด 
 
จากตารางที่ 4.2 แสดงการประเมินความพึงพอใจต่อการใช้เทคโนโลยีความจริงเสริมการเรียน

การสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดยผู้เชี่ยวชาญ และอาจารย์ พบว่า ผลการ
ประเมินภาพรวมอยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.58 เมื่อพิจารณาเป็นรายด้าน สรุปได้ดังนี้ 

ด้านความเนื้อหาพบว่า ภาพรวมอยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.58 เมื่อพิจารณาเป็นรายข้อ 
พบว่า เนื้อหาบทเรียนมีความสอดคล้องกบัวัตถุประสงค์ อยู่ในระดับมาก มีค่าเฉลี่ย 4.33 การใช้ภาษา
สามารถสื่อความหมายได้ชัดเจน อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 เนื้อหาสามารถเข้าใจได้ง่าย 
อยุ่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 เนื้อหาของสื่อเป็นประโยชน์ต่อสังคม อยู่ในระดับมากที่สุด  
มีค่าเฉลี่ย 4.67  

ด้านกราฟิกและการออกแบบพบว่า ภาพรวมอยู ่ในระดับมากที่ส ุด มีค่าเฉลี ่ย 4.67 เมื่อ
พิจารณาเป็นรายข้อพบว่า การออกแบบหนังสือมีความสวยงาม อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 
รูปภาพประกอบสามารถสื ่อความหมาย และมีความสอดคล้องกับเนื ้อหา อยู ่ในระดับมากที่สุด  
มีค่าเฉลี ่ย 4.67 วีดีโอภาษามือสามารถเข้าใจได้ง่าย อยู ่ในระดับมากที่สุด มีค่าเฉลี ่ย 4.67 เสียง
บรรยาย และเสียงประกอบเหมาะสมกับเนื้อหา อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 

ด้านเทคนิคพบว่า ภาพรวมอยู่ในระดับมาก มีค่าเฉลี่ย 4.50 เมื่อพิจารณาเป็นรายข้อ พบว่า  
มีวิธีการใช้งานที่เข้าใจง่ายและสะดวก อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 การใช้งานแอปพลิเคชัน
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ง่าย ไม่ซับซ้อน อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 มีเทคนิครูปแบบการนำเสนอผ่านอุปกรณ์ที่
เหมาะสม อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 ประสิทธิภาพในการใช้งานโดยรวมมีความเหมาะสม 
อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.58 
 

4.3 ผลการประเมินความพึงพอใจของนักเรียนระดับชั้นประถมศึกษาปีที่ 4 โรงเรียน
เศรษฐเสถียร ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความ
จริงเสริมในรูปแบบเทคโนโลยี AR 
 การประเมินความพึงพอใจของการใช้เทคโนโลยีความจรงิเสริมการเรียนการสอนสำนวนไทย

สำหรับผู้บกพร่องทางการได้ยิน โดยมีกลุ่มตัวอย่างคือนกัเรยีนที่เป็นผู้บกพรอ่งทางการได้ยิน ซึง่เป็น

นักเรียนระดับช้ันปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ เป็นผู้ประเมินความพึงพอใจหลงัจาก

ได้ทดลองใช้สือ่ ซึ่งทำการวิเคราะห์ข้อมลูด้วยการหาค่าร้อยละ (%) ค่าเฉลี่ย (x̅) และส่วนเบี่ยงเบน

มาตราฐาน (S.D.) สามารถนำเสนอผลการวิเคราะห์ข้อมูลไดด้ังนี้ 

4.3.1 ข้อมูลส่วนบุคคล ได้แก่ เพศ โดยทำการวิเคราะห์ด้วยการแจกแจงความถ่ี และค่าร้อย
ละ ดังนี ้

 
ตารางที่ 4.3 ข้อมูลพื้นฐานของผู้ตอบแบบสอบถาม จำแนกตามเพศ 

เพศ จำนวน ร้อยละ 
1. ชาย 5 25 
2. หญิง 15 75 

รวม 20 100 
 
จากตารางที่ 4.3 แสดงข้อมูลพื้นฐานของผู้ตอบแบบสอบถาม จำแนกตามเพศ พบว่า ส่วนใหญ่

เป็นเพศหญิง ร้อยละ 75 และเพศชาย ร้อยละ 25 
 
4.3.2 เกณฑ์การประเมินของระดับความพึงพอใจในการใช้ความจริงเสริมในการสร้างสื่อ

เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดยกำหนด
เกณฑ์การประเมินความพึงพอใจออกเป็น 3 ระดับ ดังนี้ 

 3  หมายถึง  มีคุณภาพอยู่ในระดับมาก 
 2  หมายถึง  มีคุณภาพอยู่ในระดับปานกลาง 
 1  หมายถึง  มีคุณภาพอยู่ในระดับน้อย 
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  และใช้เกณฑ์ตามมาตราวัดของลิเคิร์ท (Likert Scale) แปลความหมายดังนี้ 
 คะแนนค่าเฉลี่ย  2.34-3.00  หมายถึง  มาก 
 คะแนนค่าเฉลี่ย  1.67-2.33  หมายถึง  ปานกลาง 
 คะแนนค่าเฉลี่ย  1.00-1.66  หมายถึง  น้อย 
 

ตารางที่ 4.4 ผลการประเมินความพึงพอใจของนักเรียนระดับช้ันประถมศึกษาปีที่ 4 โรงเรียนเศรษฐ
เสถียร ในพระราชูปถัมภ์ต่อหนังสือเสริมการเรียนการสอนผา่นเทคโนโลยีความจรงิเสรมิ
ในรูปแบบเทคโนโลยี AR 

รายการท่ีทำการประเมิน 

ระดับความพึงพอใจ ผลการวิเคราะห์ข้อมูล 
มาก 

 
(3) 

ปาน
กลาง 
(2) 

น้อย 
 
(1) 

𝐱̅ S.D. ระดับ 
ความ 

พึงพอใจ 
1. มีเน้ือหาเหมาะสมกับผู้เรียน 17 1 2 2.75 0.63 มาก 
2. มีรูปแบบการนำเสนอที่น่าสนใจ 9 9 2 2.35 0.67 มาก 
3. สื่อความหมายและเข้าใจในบทเรียน 10 9 1 2.45 0.60 มาก 
4. ตัวละครในหนังสือและวีดีโอมีความ
สวยงาม 

14 6 - 2.70 0.47 มาก 

5. การใช้สี ตัวอักษร มีความเหมาะสม 8 11 1 2.35 0.58 มาก 
6. เสียงบรรยาย และเสียงประกอบ
เหมาะสมกับเน้ือหา 

3 8 9 1.70 0.73 ปานกลาง 

7. วีดีโอภาษามือเข้าใจได้ง่าย 17 3 - 2.85 2.85 มาก 
8. แอปพลิเคชันใช้งานได้อย่างมี
ประสิทธิภาพ 

9 10 1 2.40 2.40 มาก 

9. ผลงานมีประโยชน์ต่อผู้เรียน 13 7 - 2.65 2.65 มาก 
7. วีดีโอภาษามือเข้าใจได้ง่าย 17 3 - 2.85 2.85 มาก 

ความเหมาะสมในภาพรวม 2.46 0.57 มาก 

 
 จากตารางที่ 4.3 แสดงการประเมินความพึงพอใจต่อการใช้เทคโนโลยีความจริงเสริมการเรียน
การสอนสำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดยกลุ่มตัวอย่างคือนักเรียนที่เป็นผู้บกพร่อง
ทางการได้ยิน ซึ่งเป็นนักเรียนระดับช้ันปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ พบว่า ผลการ
ประเมินภาพรวมอยู่ในระดับมาก มีค่าเฉลี่ย 2.46 เมื่อพิจารณาแล้ว สรุปได้ดังนี้ มีเนื้อหาเหมาะสมกบั
ผู้เรียน อยู่ในระดับมาก มีค่าเฉลี่ย 2.75 มีรูปแบบการนำเสนอที่น่าสนใจ อยู่ในระดับมาก มีค่าเฉลี่ย 
2.35 สื่อความหมายและเข้าใจในบทเรียน อยู่ในระดับมาก มีค่าเฉลี่ย 2.45 ตัวละครในหนังสือและ
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วีดีโอมีความสวยงาม อยู่ในระดับมาก มีค่าเฉลี่ย 2.70 การใช้สี ตัวอักษร มีความเหมาะสม อยู่ ใน
ระดับมาก มีค่าเฉลี่ย 2.35  เสียงบรรยาย และเสียงประกอบเหมาะสมกับเนื้อหา อยู่ในระดับปาน
กลาง มีค่าเฉลี่ย 1.70 วีดีโอภาษามือเข้าใจได้ง่าย อยู่ในระดับมาก มีค่าเฉลี่ย 2.85 แอปพลิเคชันใช้
งานได้อย่างมีประสิทธิภาพ อยู่ในระดับมาก มีค่าเฉลี่ย 2.40 ผลงานมีประโยชน์ต่อผู้เรียน อยู่ในระดับ
มาก มีคา่เฉลี่ย 2.65 วีดีโอภาษามือเข้าใจได้ง่าย อยู่ในระดับมาก มีค่าเฉลี่ย 2.85 



 

บทท่ี 5 
สรุปผล อภิปราย และข้อเสนอแนะ 

 
 จากการดำเนินโครงงานเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับ 
ผู้บกพร่องทางการได้ยิน สามารถนำผลการวิจับมาสรุปผล อภิปรายผล และข้อเสนอแนะได้ดังนี้ 
 5.1 สรปุผลการศึกษา 
 5.2 อภิปราย 
 5.3 ข้อเสนอแนะ  
 

5.1 สรุปผลการศึกษา 
 การวิจัยเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพรอ่งทางการ
ได้ยิน สามารถสรุปผลการวิจัย ดังนี้ 
 5.1.1 วัตถุประสงค์การวิจัย 
  5.1.1.1 เพื่อผลิตสื่อเทคโนโลยีความจริงเสรมิในรูปแบบเทคโนโลยี AR เกี่ยวกับกลุ่ม
สาระการเรียนรู้ภาษาไทย ในหมวด สำนวนไทย 
  5.1.1.2 เพื่อศึกษาความพึงพอใจของผู้เรียนต่อหนังสือเสริมการเรียนการสอนผ่าน
เทคโนโลยีความจริงเสริมในรูปแบบเทคโนโลยี AR 
 5.1.2 วิธีการดำเนินโครงงาน 
  5.1.2.1 ด้านเนื้อหา 
   การศึกษาครั้งนี้ได้อิงเนื้อหาจากในกลุ่มสาระการเรียนรู้ภาษาไทย สำหรับ
ชั้นประถมศึกษา ชั้นปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ โดยมุ่งเน้นศึกษาในเรื่องของ 
สำนวนไทย เพื่อนำมาใช้พัฒนาร่วมกับสื่อเสริมการเรียนการสอน 
  5.1.2.2 ด้านประชากรและกลุ่มตัวอย่าง 
   ประชากรที่ใช้ในการศึกษาครั ้งนี้แบ่งออกเป็น 2 กลุ ่ม คือ นักเรียนช้ัน
ประถมศึกษาปีที่ 4 โรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์ จำนวน 20 คน และอาจารย์ประจำ
โรงเรียนเศรษฐเสถียรในพระราชูปถัมภ์ จำนวน 3 คน 
  5.1.2.3 ด้านตัวแปรที่ศึกษา 
   ตัวแปรต้น = หนังสือความจริงเสริมในรูปแบบเทคโนโลยี AR 
   ตัวแปรตาม = ความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 4 โรงเรียน
เศรษฐเสถียรในพระราชูปถัมภ์ และอาจารย์ประจำโรงเรยีนเศรษฐเสถียรในพระราชูปถัมภ์ ต่อหนังสือ
ความจริงเสริมในรูปแบบเทคโนโลยี AR 
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  5.1.2.4 ด้านพื้นที่ 
   โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ 
  5.1.2.5 ด้านเวลา 
   ระยะเวลาที่ทำการศึกษาค้นหาข้อมูลเพื ่อนำเสนอ จนถึงการเผยแพร่  
ใช้ระยะเวลาต้ังแต่ เดือนธันวาคม พ.ศ. 2561- กุมภาพันธ์ พ.ศ. 2563 
 5.1.3 ผลการศึกษา 
  ผลการประเมินความพึงพอใจต่อการใช้เทคโนโลยีความจริงเสริมการเรียนการสอน
สำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดยผู้เช่ียวชาญ และอาจารย์ พบว่า ผลการประเมินภาพ
รวมอยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.58 เมื่อพิจารณาเป็นรายด้าน พบว่า ด้านเนื้อหา อยู่ในระดับ
มากที่สุด มีค่าเฉลี่ย 4.58 ด้านกราฟิกและการออกแบบ อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.67 และ
ด้านเทคนิค อยู่ในระดับมากที่สุด มีค่าเฉลี่ย 4.50 
  ผลการประเมินความพึงพอใจต่อการใช้เทคโนโลยีความจริงเสริมการเรียนการสอน
สำนวนไทยสำหรับผู้บกพร่องทางการได้ยิน โดยกลุ่มตัวอย่างคือนักเรียนที่เป็นผูบ้กพร่องทางการไดย้นิ 
ซึ่งเป็นนักเรียนระดับชั้นปีที่ 4 โรงเรียนเศรษฐเสถียร ในพระราชูปถัมภ์ พบว่า ผลการประเมินภาพ
รวมอยู่ในระดับมาก มีค่าเฉลี่ย 2.46  
 

5.2 อภิปรายผลการศึกษา 
 จากการศึกษาเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับผู้บกพร่อง
ทางการได้ยิน พบว่า หนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความจริงเสริมในรูปแบบ
เทคโนโลยี AR ที่พัฒนาข้ึนน้ัน ได้รับความพึงพอใจจากกลุ่มผู้เช่ียวชาญ และอาจารย์ อยู่ในระดับมาก
ที่สุด และนักเรียนที่เป็นผู้บกพรอ่งทางการได้ยิน ซึ่งเป็นนักเรียนระดับช้ันปีที่ 4 โรงเรียนเศรษฐเสถียร 
ในพระราชูปถัมภ์ อยู่ในระดับมาก โดยผลงานวิจัยที่ได้ออกมาน้ันสอดคล้องกับงานวิจัยของ สุบิน ไชย
ยะ (2560: บทนำ) ที่ศึกษาเรื่องการใช้เทคโนโลยีเสมือนจริงในห้องสมุดประชาชน และได้ผลสรุปว่า 
การนำเทคโนโลยีเสมือนจริงมาใช้ในห้องสมุดประชาชนถือเป็นมิติใหม่ทางด้านสื่อการเรียนรู้ทำให้
ผู้ใช้บริการ มีความสนใจใฝ่เรียนรู้อยากรู้อยากเห็น เรียนรู้สิ่งใหม่ สร้างประสบการณ์ที่แปลกใหม ่และ
มีส่วนร่วมในการเรียนรู้ได้เพิ่ม มากขึ้น  

 
5.3 ข้อเสนอแนะ 
 5.3.1 ข้อเสนอแนะจากการศึกษา 
  จากการศึกษาเรื่อง เทคโนโลยีความจริงเสริมการเรียนการสอนสำนวนไทยสำหรับ 
ผู ้บกพร่องทางการได้ยิน พบว่า หนังสือเสริมการเรียนการสอนผ่านเทคโนโลยีความจริงเสริมใน
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รูปแบบเทคโนโลยี AR ที่พัฒนาข้ึนน้ัน ได้รับความพึงพอใจอยู่ในระดับมาก และมากที่สุด ซึ่งแสดงให้
เห็นว่าการพัฒนาสื่อในครั้งนี้เป็นไปได้ด้วยดี และได้รับผลตอบกลับที่น่าพึงพอใจ แต่ควรศึกษาเรื่องใช้
โปรแกรม Unity ให้ชำนาญมากกว่าน้ี เพื่อให้ได้การแสดงผลที่เสถียรมากกว่าน้ี 
 5.3.2 ข้อเสนอแนะในการศึกษาครั้งต่อไป 
  จากการศึกษาในครั ้งนี ้คณะผู ้จัดทำเห็นว่าควรมีการพัฒนารูปแบบการนำเสนอที่
น่าสนใจกว่าน้ี เช่น การสร้างเนื้อหาเป็นนิทานหรือเรื่องเล่า เพื่อให้เด็ก ๆ สนุกไปกับเนื้อหามากกว่านี้ 
รวมไปถึงการพัฒนาแอปพลิเคชันให้ใช้ได้ทั้งระบบ iOS และ Android และนำแอปพลิเคชันนั้นไป
ติดตั้งใน Apple App Store หรือ Google Play Store เพื่อสะดวกต่อการดาวน์โหลดแอปพลิเคชัน
มาใช้  
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หนังสือขอความอนุเคราะห์ 
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ภาคผนวก ข 

ภาพแบบร่างเนื้อหา 
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ภาพที่ 1  ภาพร่างเนื้อหา (1) 
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ภาพที่ 2  ภาพร่างเนื้อหา (2) 
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ภาพที่ 3  ภาพร่างเนื้อหา (3) 



 
 
 
 
 
 
 
 
 
 

ภาคผนวก ค 
ภาพการใช้สื่อ 
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ภาพท่ี 1  ทดลองสแกน AR (1) 

 

 
 

ภาพท่ี 2  ทดลองสแกน AR (2) 



 
 

 

 

 

 

 

 

 

 

 

ภาคผนวก ง 

เคร่ืองมือท่ีใช้ในการรวบรวมข้อมูล 

 

 

 

 

 

 

 

 

 

 

 



69 
 

 

 

ภาพที่ ง.1  แบบสอบถามความพึงพอใจนักเรียน 
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ภาพท่ี 2  แบบสอบถามความพึงพอใจผู้เชี่ยวชาญ (1) 
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ภาพท่ี 3  แบบสอบถามความพึงพอใจผู้เชี่ยวชาญ (2) 



 
 

 

 

 

 

 

 

 

 

 

 

ภาคผนวก จ 
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ภาพท่ี 1  บรรยากาศการบันทึกวีดีโอภาษามือ (1) 

 

 
 

ภาพท่ี จ.2  บรรยากาศการบันทึกวีดีโอภาษามือ (2) 
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ภาพท่ี 3  บรรยากาศการบันทึกวีดีโอภาษามือ (3) 
 

 
 

ภาพท่ี จ.4  นำตัวอย่างหนังสือและแอปพลิเคชั่นไปตรวจสอบ 
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ภาพท่ี จ.5  ทดลงติดต้ังแอปพลิเคชั่น (1) 

 

 
 

ภาพท่ี จ.6  ทดลงติดต้ังแอปพลิเคชั่น (2) 
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ภาพที่ 7 นักเรียนลองใช้งานหนงัสือและแอปพลเิคช่ัน (1) 

 

 
 

ภาพที่ 8  นักเรียนลองใช้งานหนังสือและแอปพลิเคช่ัน (2) 
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ภาพที่ 9  นักเรียนลองใช้งานหนังสือและแอปพลิเคช่ัน (3) 

 

 
 

ภาพที่ 9  นักเรียนลองใช้งานหนังสือและแอปพลิเคช่ัน (4) 
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ภาพท่ี 10 มอบหนังสือ AR สำนวนำทย ให้กับโรงเรียนเศรษฐเสถียร์ ในราชูปถัมภ์ 
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